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Name and address of the manufacturer: 
 Younes Sleep Technologies (YST) 

 1 Morley Avenue, Princess Elizabeth Building 

 Winnipeg, Manitoba R3L 2P4 

 Canada 

             Tel: 1-888-942-6774 

  
Name and address of the EU Authorized Representative: 

 

 

EC REP 
 

 

 

 

 

 

Name and address of the Australian Sponsor: 

 

CE Mark:  

             

  0086 

Intended Use  
 
The MICHELE Sleep Scoring System is a computer program (software) intended for use as an aid for 

the diagnosis of sleep and respiratory related sleep disorders. 

The MICHELE Sleep Scoring System is intended to be used for analysis (automatic scoring and 

manual rescoring), display, redisplay (retrieve), summarizing, reports generation and networking of digital data 

collected by monitoring devices typically used to evaluate sleep and respiratory related sleep disorders.  

The device is to be used under the supervision of a physician. Use is restricted to files obtained from 

adult patients. 

 

Warnings and Cautions 
The MICHELE Sleep Scoring System does not analyze data that are different from those analyzed by 

human scorers. The report generated by the MICHELE Sleep Scoring System contains numerical and graphical 

data typical of those generated following manual scoring of polysomnograms.  It does not contain any 

interpretation, diagnosis, or recommendations for treatment.  These decisions are to be made by the treating 

physician.   

The scoring provided by the MICHELE Sleep Scoring System must be reviewed, edited as necessary 

and approved before the report is generated. 

Special attention should be paid to confirm the first epoch of REM sleep and of non-REM sleep since, 

occasionally, brief periods of either kind can be missed or mistakenly scored resulting in large errors in sleep 

latency or REM latency. 

Arousals may be underreported in cases where arousal frequency is very high. 

 Any modification to any component of the MICHELE Sleep Scoring System may result in erroneous 

results or failure of the software to operate. 

If data files are sent to YST for processing or troubleshooting, failure to remove confidential patient 

information from the file may result in breach of patient privacy if files are lost in transit or accessed by 

unauthorized personnel. 

Caution: US Federal law restricts this device to sale by or on the order of a physician. 

Emergo Australia 

Level 20  

Tower II, Darling Park  

201 Sussex Street 

Sydney, NSW 2000 

Australia 

 

Advena Ltd. 

Pure Offices 

Plato Close 

Warwick, CV34 6WE 

UK 
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Introduction 
 

The MICHELE Sleep Scoring System (MICHELE) is a software system that automatically scans 

physiological data recorded during sleep studies, referred to as polysomnography (PSG) records, and 

applies a variety of analytical approaches to identify the occurrence of certain events that relate to the 

presence and type of sleep-state, breathing abnormalities and limb movements. The system is capable of 

scoring Sleep Stages, Arousals, Respiratory Events and Leg Movements.  At the end of the analysis the 

system generates a PSG Report that includes tables and graphs typical of those generated following 

manual scoring of PSG records by certified technologists. The results of the automated scoring may be 

displayed using the PSG Scoring Viewer (referred to as Viewer in this User Manual) application, which 

allows manual editing of the results and generation of a revised PSG Report. 

 

The Autoscoring software package is currently not available to users outside of YST.  The Autoscoring is 

currently provided as a service by YST; users may access the Autoscoring feature remotely via File 

Transfer Protocol (FTP) using the Viewer software, as described in Section 4. 

 

User Training  
 
This User Manual provides a comprehensive description of the full capabilities of MICHELE, and in 

particular of the Viewer.  The User Manual – along with descriptions of functions within the Viewer user 

interface – comprises the primary training material for use of MICHELE and the Viewer.  It is strongly 

recommended that users read this User Manual at least once prior to using the Viewer, and that users refer 

to the User Manual as often as needed in conjunction with use of the Viewer.  Additional training may be 

provided on-site and/or via video by YST personnel, covering both installation and use of the software. 

 

Any user should have a prior understanding of the physiological signals associated with PSG studies, and 

should be appropriately qualified in the scoring and interpretation of PSG records, as per a physician in 

sleep medicine or a Registered Polysomnographic Technologist (RPSGT).  Appropriate qualifications and 

training (as described above) will enhance the user’s experience with MICHELE and ensure accuracy in 

scoring and report generation. 

 

1.0 System Overview 

 

 System Requirements 

 

1.1.1. The Viewer has been verified to work with Windows® XP and Windows® 7. 

 

1.1.2. The Viewer requires a minimum of 4GB of RAM. 

 

1.1.3. Processor requirement is 1.6 GHz or faster.  

 

1.1.4. Monitor requirement 19 inch or greater, 1280 X 1024 resolution or greater. 

 

1.1.5. Keyboard and mouse for control, and a printer if hard copies are required.  

 

1.1.6. 50 MB of free hard drive space. 
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1.1.7. Patient files must be in the .EDF format.  

 

1.1.8. A new directory must be created for each patient file. 

 

1.1.9. Access to the Internet is required 

 

1.1.10. Outgoing (UDP) traffic on port 53 is allowed to hosts ns1.younessleeptechnologies.com and 

ns2.younessleeptechnologies.com.  This is required to implement automated failover in the 

event of a YST server outage.  For more information, contact YST Support (contact 

information provided in Section 8.2). 

  

 Data Collection Requirements 

 

In order to properly execute the automated scoring module embedded in the Viewer, the PSG data must 

meet the requirements described in this section.  Section 3.8 elaborates on the signals that the Viewer is 

capable of analyzing as well as the signals that are mandatory for data processing. 

 

1.2.1 Electrode positioning and Impedance 

Electrode placement should follow the Standard Placement procedures (as per Rechtschaffen and Kales). 

Electrode impedance should be <5K. 

 

1.2.2 Sampling rate  

The sampling rate should be a minimum of 120 Hz for AC channels (EEG, EOG, EKG, EMG and 

Audio), a minimum of 20 Hz for Respiratory signals (Thermister, Flow, Respiratory bands, Airway 

pressure, Airway CO2), a minimum of 5 Hz for SpO2 and a minimum of 1 Hz for body position, if 

position is recorded directly in the digital file. 

 

1.2.3 Signal filtering of AC channels (EEG, EOG, EKG, EMG and Audio) 
Filtering must be performed either in hardware (at the amplifiers) or in the software after recording. If you 

use hardware filters, you should export the file into the .EDF format without any additional filtering. If 

you do not use the hardware filters, it is recommended that you export the file without additional filters.  

 

You will be asked, as described in Section 4.2, whether the file has been pre-filtered (either by hardware 

or during export) before automated scoring begins.  

 

If the signals are to be filtered by hardware or during export, each of the 5 primary AC channels must be 

filtered as per the American Academy of Sleep Medicine (AASM) guidelines shown below. In addition, a 

60 Hz notch filter must be used where available. 

 

 Low Frequency Filter High Frequency Filter 

EEG 0.3 Hz 30-35 Hz (preferably 30) 

EOG 0.3 Hz 30-35 Hz (preferably 30) 

EMG 10 Hz 100 Hz 

ECG 0.3 Hz 70 Hz 

Audio 10 Hz 100 Hz 
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1.2.4 Signal referencing 

As with filtering (Section 1.2.3), referencing of AC signals must be performed either in the hardware (at 

the amplifiers) or in the software after recording. 

 

If you use the hardware referencing, you should export the file into the .EDF format without any 

additional referencing. If you do not use hardware referencing, it is recommended that you export the file 

without referencing.  Referencing can be done through the interface provided with the Viewer. 

 

You will be asked, as described in Section 4.2, to confirm that the AC channels have been referenced (by 

hardware, during export or through the Viewer interface) before automated scoring begins.  

 

1.2.5 Signal noise  

Noise should be kept to a minimum through appropriate cable insulation and connections.  Although the 

software continuously evaluates the signal quality of certain channels and in those cases uses only signals 

that meet minimum quality criteria, as a best practice noise should be minimized as signals that are 

damaged or noisy can greatly affect scoring quality.  If desired, YST staff can advise you on ways to 

reduce the noise.  (Section 8 of this User Manual provides contact information). 

 

1.2.6 Calibration  

All AC signals must be calibrated using a 50V calibration switch. 

 

 Scoring Rules Used  

 

The MICHELE Sleep Scoring System adheres to the most recent guidelines of the American Academy of 

Sleep Medicine (The AASM Manual for the Scoring of Sleep and Associated Events, 2007). Specifically: 

 

1.3.1 Identification of sleep stages  

This is done according to the Rechtschaffen & Kales rules, as modified by the new 2007 AASM 

guidelines, from analysis of the frequency profile of the EEG, presence of EEG spindles, k complexes and 

delta waves, level of chin EMG, and eye movements. Each 30-second epoch of data will be designated as 

being in stage W (awake), REM sleep, N1 Non-REM sleep, N2 Non-REM sleep, or N3 Non-REM sleep. 

 

1.3.2 Detection of arousals  

Each 30-second epoch will be searched for the presence of one or more arousals following the guidelines 

of the American Sleep Disorders Association (Sleep 15: 174–184, 1992). Whenever an arousal is found, it 

will be classified as respiratory-related, leg movement-related or spontaneous, based on the temporal 

relation of the arousal to preceding events. 

 

1.3.3 Detection of respiratory events  
Each 30-second epoch is searched for the presence of one or more respiratory events characterized by 

reduction (hypopnea) or complete cessation (apnea) of airflow in and out of the patient or Respiratory 

Effort Related Arousal (RERA). Whenever an apnea is detected, it will be characterized as central, 

obstructive or mixed. The software uses the guidelines established by the AASM (The AASM Manual for 

the Scoring of Sleep and Associated Events published by the AASM in 2007). The user will have the 

choice of identifying hypopneas according to criteria A or criteria B of the 2007 AASM guidelines. With 

criteria A, a hypopnea is identified if the amplitude of the breathing channel used decreases by 30% 

from the reference value for  10 seconds and is associated with 4% decrease in oxyhemoglobin 
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saturation (SpO2).  With criteria B, a hypopnea is identified if the amplitude of the breathing channel 

used decreases by 50% from the reference value for  10 seconds and is associated with an arousal or 

3% decrease in SpO2. The software continuously evaluates the signal quality of the various respiratory 

channels (nasal cannula flow (or CPAP flow), thermister, and chest and abdomen bands) and uses only 

signals that meet minimum quality criteria. If more than one channel is of acceptable quality, the 

amplitude criteria are assessed from nasal flow (or CPAP flow if patient is on CPAP), if valid. If not, the 

thermister is used and if this is not valid also, the chest and abdomen bands signals are used to assess 

amplitude changes. 

 

Hypopneas identified by either criterion are further classified into obstructive or undefined. An 

obstructive hypopnea is one where there is associated snoring and/or chest wall paradox and/or flow 

limitation. An undefined hypopnea is one that lacks these features. It should be emphasized that lack of 

these features does not rule out an obstructive basis for the hypopnea. Hence, such hypopneas are called 

undefined, meaning they can be obstructive or central. 

 

1.3.4  Detection of leg movements 

Each 30-second epoch is searched for the presence of one or more leg movements. Whenever a leg 

movement is found, it will be characterized as associated or not with arousal and whether the leg 

movements follow a periodic pattern (periodic leg movements (PLMs)) following the guidelines 

established by the American Academy of Sleep Medicine (The AASM Manual for the Scoring of Sleep 

and Associated Events published by the AASM in 2007).  

 

1.4 Reported Variables 

 

When a file is scored and edited/approved by the technologist, a report will be generated. The report has 

two components, numerical and graphical. The default report contains all values and graphs that are 

available. The user may choose to omit some values from the report using a procedure described below in 

the “Generate Report” Function (Section 6). In the event the study was a split study, there will be two 

numerical reports in the same document, one for the pre-CPAP period and one for the On-CPAP period.  

 

1.4.1 Numerical Report  

This consists of several sections that relate to the output of the different functions of the software; namely, 

sleep variables, arousals detected, periodic leg movements (PLMs) and respiratory events. The following 

paragraphs describe how each value is calculated: 

 

1.4.1.1 “SLEEP VARIABLES” Box: This table presents an all-night summary of relevant sleep data (i.e. 

it includes pre-CPAP and on-CPAP times in the case of split studies). Each number in this table is 

calculated according to the 2007 guidelines of the AASM. 

1.4.1.1.1  Lights Off clock time 

1.4.1.1.2  Lights ON clock time 

1.4.1.1.3 Total Sleep Time (TST): TST is calculated from the sum of all periods scored as N1-N3 and 

REM between Lights Off and Lights ON. It is reported in minutes. 

1.4.1.1.4 Total Recording Time: Difference between Lights On and Lights Off in minutes. 

1.4.1.1.5 Sleep Efficiency: This is calculated from TST *100 / Total Recording Time. 

1.4.1.1.6  Sleep Latency: Time from Lights Off to Sleep Onset. Sleep Onset is the first time there is a 

change to stage N1, N2, N3 or REM. 

1.4.1.1.7  Wake After Sleep Onset (WASO): Total time in stage Awake minus Sleep Latency. 
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1.4.1.1.8  REM Latency: Time when REM sleep first appeared minus Time at which any sleep (N1, N2, 

N3, or REM) first appeared.  

1.4.1.1.9  Sleep Period Time: Time from Sleep Onset to Lights On. 

1.4.1.1.10  REM Latency Minus Wake Time: REM Latency minus sum of all periods in stage awake 

between lights Off and REM Onset. 

1.4.1.1.11 Stage 1 Cycles: Number of times patient entered stage N1 sleep.  

1.4.1.1.12 Total Awakenings: Number of times sleep-state changed from any sleep stage to stage awake. 

1.4.1.1.13 Total Stage Shifts: Total number of shifts from any stage to any other stage. 

 

1.4.1.2 “TIME IN EACH STAGE” box: The time spent in each of the five stages (awake, N1, N2, N3, 

and REM) is given in minutes and as % of TST. The latency to entering each stage, provided in the last 

column, is the time of first appearance of the stage minus Lights Off. The sum of all times spent in non-

REM sleep (sum of stages N1 to N3 in the same table) is reported at the bottom of the table. With split 

studies the values in this box and subsequent boxes reflect either the Pre-CPAP or the On-CPAP period, 

as indicated in the heading above this box. 

 

1.4.1.3 “AROUSALS” box: The arousal statistics are reported into three categories (Respiratory-related, 

PLM-related and Spontaneous): 

1.4.1.3.1 Respiratory Arousals: Arousals are attributed to respiratory events if they start within 5 

seconds of the end of a respiratory event. 

1.4.1.3.2 Arousals with PLMs: As per AASM guidelines, an arousal is attributed to a leg movement if 

there is A) overlap between arousal time and PLM time, OR B) an arousal end in the interval PLM onset 

to PLM onset –0.5 second, OR C) an arousal onset in the interval PLM end to PLM end +0.5 second. At 

times, recurrent respiratory events are associated with recurrent arousals that involve leg movements. In 

such cases, the arousal is classified as Respiratory-related. 

1.4.1.3.3  Spontaneous Arousals: These are arousals that are not associated with Respiratory events or 

with PLMs. 

1.4.1.3.4 Total arousals: Sum of all arousals 

1.4.1.3.5 Total arousals + awakenings: Sum of arousals and awakenings (from the SLEEP VARIABLES 

box). 

 

For each arousal category, arousals are separately reported for REM sleep and non-REM sleep periods. 

for each arousal category. All arousal data are reported both as numbers (of arousals) and as an Arousal 

Index. The latter index represents the per-hour frequency of occurrence of a certain category of arousals 

during a specified sleep-state. For example, the Total Arousal Index for non-REM sleep is given by the 

total number of arousals in non-REM sleep divided by total time (in hours) spent in non-REM sleep. 

 

1.4.1.4 “LEG MOVEMENTS” box: The top section of this box reports all leg movements whether they 

meet the periodic criteria or not. The lower section reports leg movements that meet the PLM criteria 

published in the 2007 AASM guidelines. These criteria exclude leg movements that occur in the interval 

between 0.5 seconds before the start of a respiratory event and 0.5 seconds after the end of the respiratory 

event.  

 

Within each category, the leg movements with and without arousal are reported separately. Both 

categories of leg movements (PLMs or Total) are reported separately for REM sleep and for each of the 

different stages of non-REM sleep. The Index represents the per-hour frequency of occurrence of a certain 

category of leg movements during a specified sleep-state. For example, the PLM index for non-REM 
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sleep is given by the total number of PLMs in non-REM sleep divided by total time (in hours) spent in 

non-REM sleep. 

 

1.4.1.5 “RESPIRATORY EVENTS BY SLEEP STAGE” box: The first column in this table reports the 

total number of each type of Respiratory Event that occurred during sleep, along with the relevant Index 

(i.e. number / total sleep time in hours). At the bottom of the first column the total number of apneas 

along with relevant index (Apnea Index) are reported. The sum of all apneas and hypopneas, along with 

the Apnea + hypopnea index (AHI) are also reported. Finally, the sum of all 6 categories (Apneas + 

hypopneas +RERAs) and its index are given. These three Indices are calculated by dividing the relevant 

number by TST in minutes and then multiplying by 60. 

 

In the next two columns the total number within each category is broken into numbers occurring in REM 

sleep and in non-REM sleep. For each such number the relevant Index is obtained by dividing the number 

by total sleep time in minutes of  the relevant sleep stage and then multiplying by 60. 

 

The last column shows the average and maximum durations of events in each respiratory event category.  

 

1.4.1.6 “RESPIRATORY EVENTS BY BODY POSITION” box: The first column in this table is 

identical to the first column in the preceding table and provides the number, and index, of events in each 

category in all body positions. The total numbers are then subdivided by body position. The Indexes are 

obtained by dividing the number of events in a given position by the time (in hours) spent asleep in this 

body position.  

 

1.4.1.7  “O2 SATURATION STATISTICS” box: This table lists a number of statistics related to SpO2 

data (% oxygen saturation of hemoglobin). The following values are reported:  

1.4.1.7.1 Maximum: The highest valid SpO2 between Lights Out and Lights On. 

1.4.1.7.2 Average: The average of all valid SpO2 data between Lights Out and Lights On. 

1.4.1.7.3 Minimum: The lowest valid SpO2 between Lights Out and Lights On. 

1.4.1.7.4 # desaturations >2%: Total number of events where SpO2 decreased by >2%. 

1.4.1.7.5 Desaturation Index: # desaturations >2% / Total Sleep Time in hours. 

1.4.1.7.6 # desaturations >3%: Total number of events where SpO2 decreased by >3%. 

1.4.1.7.7 Desaturation Index: # desaturations >3% / Total Sleep Time in hours. 

1.4.1.7.8 # desaturations >4%: Total number of events where SpO2 decreased by >4%. 

1.4.1.7.9 Desaturation Index: # desaturations >4% / Total Sleep Time in hours. 

1.4.1.7.10 % Sleep Time spent in different SpO2 ranges. The table provides this data for six SpO2 ranges.  

1.4.1.7.11 % Sleep Time with bad signal. 

 

All of the above values – which pertain to the entire file – are subdivided into values that occur in REM 

vs. non-REM sleep as well as being sorted by body position. 

 

1.4.2 Graphical Report  

The graphs (see attached Report) are generated by use of the Microsoft® Chart Controls for Microsoft® 

.NET Framework 3.5. The sample report shows the default report format, which includes all seven 

possible panels; these can be adjusted to display only the desired values and graphics – see Section 6.0. 

 

1.4.2.1 The Sleep Stage and Arousal Panel: This panel displays the sleep histogram. In addition, a tick is 

placed each time an arousal occurs. 
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1.4.2.2 The Respiratory Panel: There are four groupings in this panel. Within each grouping there are the 

six types of respiratory events, central apnea (Ap C), obstructive apnea (Ap O), mixed apnea (Ap M), 

obstructive hypopnea (Hyp O), undefined hypopneas (Hyp U), and respiratory effort related arousals 

(RERA).  

 

In the first grouping (from top to bottom) a tick is placed in the appropriate row every time there is an 

entry in this category, regardless of whether the event was associated with arousal or desaturation. For 

example, if there is an obstructive apnea at time X, a tick will be placed in the Ap O row at time X. In the 

second grouping, only those events associated with arousal are represented by ticks. In the third grouping, 

only those events associated with desaturation are represented by ticks. Finally, in the bottom grouping, a 

tick is placed when an event is associated with both arousal and desaturation. 

 

The four groupings to be displayed in the graph can be selected or deselected in the generate report 

settings. The height of the Respiratory panel is adjusted automatically based on what groupings are 

selected. 

 

1.4.2.3 The Oximetry Panel: This panel shows the instantaneous oxygen saturation values as a function of 

time.  

 

1.4.2.4 The Pressure Panel: This panel shows the instantaneous airway pressure values as a function of 

time.  

 

1.4.2.5 The Audio Panel: This panel shows the instantaneous Audio level as a function of time.  

 

1.4.2.6 The Legs Panel: There are two rows in this panel. In the top row, a tick is placed for every PLM, 

regardless of whether or not it was associated with arousal.  In the lower row, a tick is placed only if the 

leg movement was associated with arousal. As indicated earlier, when an arousal is associated with both a 

PLM and a respiratory event the arousal is classified as related to a respiratory event and thus is displayed 

in the top but not the bottom row of the leg movement panel.  

 

1.4.2.7 The Body Position Panel: This panel shows the instantaneous body position as a function of time.  
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1.5 Validation Results 

 

The software performance was measured by: A) Determining epoch-by-epoch agreement between 

MICHELE’s scoring and the scoring of three technologists with respect to the four scoring functions 

(Sleep staging, Arousals, Periodic Leg Movements (PLMs) and Respiratory Events) (Objective 1). B) 

Determining the agreement between MICHELE’s results of Clinically Relevant Data, such as Total Sleep 

Time, Time in Different Stages, Apnea and Hypopnea Index (AHI…etc) and the results of the three 

technologists (Objective 2). MICHELE’s  performance, so determined, was compared with the results of 

analysis of the same validation files by one of the predicate devices, Alice 5 (510(k) Number K040595), 

using the same scoring guidelines (AASM 2007). It was also compared with the published performance 

of the two other predicate devices, Somnolyzer (K083620) and Morpheus (K022506).   

 

1.5.1 Files: Software performance was assessed using 30 full night studies recorded in the sleep 

laboratory of a tertiary care facility (Foothills Hospital, Calgary, Canada). The files were selected at 

random and included 19 patients with sleep apnea. Fifteen of these patients had moderate to severe sleep 

apnea (AHI 7338 hr
-1

) and underwent split studies with one part (pre-CPAP) where sleep was severely 

fragmented and a second part (on CPAP) with fairly normal sleep and breathing. The group also included 

9 patients with PLMs (8 to183 hr
-1

; average 3855 hr
-1

), two patients with severe sleep fragmentation for 

no apparent cause (non-organic insomnia) and seven patients with normal sleep. Overall, the quality of 

sleep varied considerably among the 30 patients with Total Sleep Time ranging from 2.6 to 7.8 hours 

(4.21.1 hours), sleep efficiency ranging from 37 to 99% (6118%) and arousal index ranging from 9 to 

97 hr
-1

 (174 hr
-1

).   A total of 24967 thirty-second epochs were scored. 

 

1.5.2 Technologists: Each of the three scorers is Board certified and has had at least 15 years of hands-on 

experience in scoring polysomnograms. 

 

1.5.3 Analytical Methods and Results:  

 

1.5.3.1 Objective 1 testing (epoch-by-epoch agreement): Table 1, left panels, shows results of epoch-by-

epoch agreement between MICHELE and a consensus (2 of the scorers agree) of the three scorers. The 

right panels show the results for a predicate device (Alice 5, referred to as Alice) using the same files and 

scoring guidelines. Positive Percent Agreement (PPA), Negative Percent Agreement (NPA), Overall % 

agreement and Cohen’s kappa (kappa) were calculated according to Altman DG et al (1). The weighted 

average of test and reference scorers was obtained for PPA (i.e. APPA) and NPA (i.e. ANPA). 

 

APPA, ANPA, Overall % agreement and kappa obtained with MICHELE exceeded the corresponding 

values obtained with Alice for all comparisons. 
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                                                                 TABLE 1                     

    AGREEMENT BETWEEN AUTO-SCORING AND CONSENSUS (2/3) OF THREE TECHNOLOGISTS  
            

                      MICHELE                          ALICE                                         

SCORING FUNCTION Total  APPA ANPA Overall % kappa Total  APPA ANPA Overall % kappa 

  by Techs.     Agreement (%) by Techs.     Agreement (%) 

SLEEP STAGING 24967     82.5 76.4 24967     30.5 6.1 

Awake 6563 88.7 96.8    6563 2.8 99.8    

N1 2411 50.6 94.7    2411 2.8 99.1    

N2 9846 81.8 90.4    9846 48.4 46.7    

N3 2862 92.8 96.0    2862 86.3 59.2    

REM 3285 86.9 99.0    3285 4.0 99.8    

No Consensus 283      283      

AROUSALS 17648   89.9 54.2 17648   57.9 10.0 

Yes 2278 60.0 94.1    2278 28.1 70.3    

None 15370      15370      

No Consensus 104      104      

PLMs 18461   95.7 68.7 18461   88.3 38.2 

Yes 1741 78.4 97.6    1741 44.7 93.4    

None 16720      16720      

No Consensus 47      47      

RESPRIRATORY EVENTS               

Criteria A 17746   94.0 74.2 17746   78.0 24.7 

Hypopnea 1513 76.3 96.6    1513 9.3 95.3    

Obstructive Apnea 329 57.1 99.2    329 14.8 92.0    

Mixed Apnea 214 79.4 99.7    214 34.8 99.1    

Central Apnea 174 64.9 99.6    174 16.7 99.1    

None 15516 96.9 89.1    15516 90.1 48.0    

No Consensus 132      132      

Criteria B 17824   93.0 70.4 17824   75.9 23.1 

Hypopnea 1822 60.3 97.6    1822 5.1 94.1    

Obstructive Apnea 359 55.9 99.3    359 15.5 91.7    

Mixed Apnea 214 83.6 99.6    214 34.2 99.1    

Central Apnea 177 63.8 99.6    177 16.6 98.9    

None 15252 98.1 75.5    15252 89.0 47.7    

No Consensus 133         133         

Numbers in Sleep Staging rows are number of 30-second epochs. Numbers in Event rows are numbers of events and 
not epochs except in the "None" category where the number refers to number of epochs with no events. 
APPA, Averaged Positive Percent Agreement; ANPA, Averaged Negative Percent Agreement; N1, N2, and N3, Non-
REM stages 1, 2 and 3; PLMs, Periodic Limb Movements; No Consensus, all three technologists gave different scores. 
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. 
1.5.3.1.1 Comparison with Other Predicate Devices: 

 

There is only one study dealing with the performance of Morpheus (2). These authors reported on the 

agreement between Morpheus and two individual (i.e. not a consensus) technologists, M1 and M2, as 

well as the agreement between M1 and M2. The paper includes data on all four functions. Data available 

for sleep staging include agreement for 5-stage scoring along with PPA for each stage and the overall 

%agreement and kappa. They also provided %agreement and kappa, but not PPA, for 4-stage scoring 

(Awake, N1+N2, N3, REM) and 3-stage scoring (awake, non-REM and REM). For scoring of arousals, 

PLM and respiratory events, they provided overall %agreement and kappa for scoring one event, two 

events or no events (3 x 3 matrix). There was no information on agreement for different categories of 

respiratory events. 

 

Two studies are available for the Somnolyzer. In one (4), the authors reported on % agreement for sleep 

stages only, in comparisons between the Somnolyzer and a 2/3 consensus of technologists. Their subjects 

were mostly normal but the study included 25 patients with sleep apnea (severity unspecified). The % 

agreement and kappa values for sleep staging by MICHELE (82.5%, Table 1) exceeded the values 

reported in this study both for the apnea patients (75.6%) and the normal subjects (80.4%).  

 

The other study on Somnolyzer (3) reported on %agreement and kappa in comparisons between the 

Somnolyzer and one scorer. Comparisons were limited to sleep staging, and the subjects were all normal.  

 

In order to compare our results with those cited above (2,3) it was necessary to analyze and report our 

data in the same fashion (i.e. one-on-one comparisons between the Auto-score and two technologists and 

between the two technologists). This is presented below for our first two scorers (S1 and S2) along with 

the agreement indices that correspond to what they reported (Table 2).  

 

Table 2 shows that the agreement between MICHELE and individual technologists equals or exceeds the 

corresponding values in the Morpheus study (2). It is to be noted that the criteria for scoring respiratory 

events used in the Morpheus study (the Chicago criteria (5)) were different from the criteria used by 

MICHELE (6), and that the latter criteria are more complex than the former. It is also notable that the 

agreement between MICHELE and each of the two technologists (S1 and S2) is substantially comparable 

to the agreement between the two technologists. The other published study dealing with the Somnolyzer 

(3) reported a % agreement of 72.3% with a kappa of 59.1% for agreement between the Somnolyzer and 

one scorer in staging sleep. The agreement between MICHELE and either technologist (S1 or S2) exceeds 

their reported value. 
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TABLE 2        

        

           COMPARISON OF MICHELE SLEEP SCORING SYSTEM AND MORPHEUS 

        

 Scoring     MICHELE Sleep Scoring System                Morpheus (2) 

Function Test reported Auto vs.S1 Auto vs. S2 S1 vs S2 Auto vs.M1 Auto vs. M2 M1 vs M2 

SLEEP (5-stage) %agreement (kappa) 80.9(74.4) 76.7(68.4) 79.6(72.3) 77.7(67.0) 73.3(61.0) 82.1(73.0) 

Awake PPA 94.4 82.6 75.0 68.7 69.6 80.9 

N1 PPA 41.4 41.9 53.6 13.1 19.9 21.3 

N2 PPA 80.9 76.1 82.9 73.5 68.9 77.1 

N3 PPA 89.7 89.2 90.5 58.0 35.3 47.7 

REM PPA 87.3 85.8 94.2 60.7 57.1 79.0 

              

SLEEP (4-stage) %agreement (kappa) 88.0(81.8) 83.3(74.6) 84.9(76.6) 82.6(71.0) 79.9(65.0) 88.7(80) 

              

SLEEP (3-stage) %agreement (kappa) 91.4(83.5) 91.1(81.8) 90.8(82.8) 88.0(75.0) 88.0(74.0) 93.5(87.0) 

              

AROUSALS (3X3) %agreement (kappa) 84.1(38.8) 87.9(49.3) 85.7(46.4) 76.2(28.0) 76.1(30.0) 83.7(57.0) 

              

PLMs (3X3) %agreement (kappa) 95.0(66.2) 94.6(67.0) 93.8(60.2) 93.1(68.0) 92.2(66.0) 95.6(77.0) 

              

RESPRIRATORY             

Chicago (3X3) %agreement (kappa)      89.7(66.0) 89.7(66.0) 94.9(82.0) 

              

Criteria A (3X3) %agreement (kappa) 94.8(78.3) 94.6(75.2) 94.9(76.4)      

              

Criteria B (3X3) %agreement (kappa) 94.3(76.5) 93.9(71.7) 93.8(74.3)       
 
1.5.3.2 Objective 2 testing: 

 

In this section we discuss agreement between automatic and manual scoring for summary variables that 

appear in the clinical report used by physicians to assess sleep disorders. Table 3 shows the results for 14 

variables. These were selected because they are the most commonly used variables in the clinical 

assessment.  

 

The first data column of Table 3 is the average score of the three technologists for each of the 14 

variables of interest. The averaging was done on a file-by-file basis. The values and corresponding 

standard deviations (SD) given in column 1 are the average and SD of the 30 averages. The second 

column contains the average and SD of the values obtained from Automatic analysis with MICHELE 

Sleep Scoring System. The third column lists the average and SD of the thirty differences between 

MICHELE and the corresponding average of the three technologists (Bland and Altman analysis). 
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Table 3:  Agreement between Manual and Automatic Scoring for Relevant Scoring  Variables 

  Average   Michele  Alice    Intra-class Correlation Coefficients 

Variable S1-S3 Michele  - ave. Alice  - ave. Michele  Alice  S1 vs. S2 vs. S3 vs. 

  SD SD SD SD SD    vs. Ave. vs.Ave.      Ave.    Ave.       Ave. 

Total sleep time (min)  312 312 0 440 128 0.983 -0.226 0.954 0.978 0.992 

  74 72 13 66 96        

              

Sleep efficiency (%) 74.6 74.7 0.1 97.0 23.0 0.985 -0.243 0.957 0.98 0.994 

  17.0 16.6 2.9 11.0 21.0        

              

Sleep-onset latency (min)  24 24 0 1 -24 0.950 -0.118 0.991 0.997 0.995 

  27 29 9 2 27        

              

REM-onset latency  126 126 0 NA NA 0.923 NA 0.988 0.966 0.992 

        (min) 71 73 28          

              

Stage wake (min) 108 108 -1 12 -97 0.986 -0.229 0.958 0.98 0.994 

  76 74 12 43 88        

              

Stage 1 (min)  47 42 -5 3 -44 0.876 -0.219 0.912 0.864 0.91 

  30 28 14 9 29        

              

Stage 2 (min)  165 159 -5 233 69 0.922 -0.288 0.983 0.964 0.972 

  54 50 20 104 131        

              

Stage 1+ 2 (min) 212 202 -10 236 24 0.923 -0.192 0.951 0.935 0.95 

  57 62 21 107 132        

              

Stage delta (min)  47 60 13 193 147 0.869 -0.132 0.940 0.847 0.948 

  38 46 17 101 100        

              

Stage REM (min)  53 51 -2 3 -50 0.951 -0.282 0.988 0.977 0.984 

  26 26 8 14 28        

              

Arousal Index (hr
-1

) 33 25 -9 54 21 0.566 -0.251 0.937 0.956 0.932 

  23 11 15 18 31        

              

PLM Index (hr
-1

) 12 13 1 43 29 0.958 0.589 0.978 0.855 0.867 

  29 31 9 42 30        

              
AHI A (hr

-1
) 30 32 2 34 4 0.982 0.369 0.992 0.974 0.988 

  41 40 7 22 34        

              

AHI B (hr
-1

) 31 27 -4 30 -2 0.971 0.384 0.99 0.967 0.986 

  42 36 8 21 35           

Average      0.918 -0.064 0.966 0.946 0.965 
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The fourth and fifth columns are the corresponding results for the predicate device (Alice). Shaded cells 

in columns 3 and 5 indicate significant difference (p 0.05) between the Auto-score (MICHELE or Alice) 

and the average of the three technologists. The last five columns contain the intra-class correlation 

coefficients for comparisons between each of the five scorers and the average score of the three 

technologists.  

 

The results show good agreement in general between MICHELE scores and the average of three 

technologists. With the exception of the arousal index where concordance (ICC) between the Auto-score 

and the average was only modest (ICC = 0.566), concordance was excellent and mostly within the range 

observed in comparisons between individual technologists and the average of the three technologists. 

Average ICC for MICHELE vs. Average was 0.918 (bottom row, table 3), only marginally below S1 

(p=0.03 by ANOVA for repeated measures) and not significantly different from S2 or S3.   

 

The results for analysis with the predicate device (Alice) are also shown in Table 3. It is clear that 

MICHELE’s performance is superior in all respects. Alice found no REM sleep in 27 of the 30 files, even 

though REM was present in 28 of the files as identified by each of the three technologists and by 

MICHELE. 

 

1.5.3.2.1 Comparison with Other Predicate Devices: 

 

Table 4 shows results for MICHELE (left 6 columns) and the only results available in the literature for 

another predicate deice (Morpheus) (2). The first three columns in each set are the average results for the 

two human scorers (S1 and S2 in the case of MICHELE, and M1 and M2 for Morpheus) and the 

corresponding automatic score. The next three columns are intra-class correlation coefficients (ICC) for 

the relation between the auto-score and the two technologists as well as the relation between the two 

technologists. 

 

As may be expected from comparisons involving a large number of pairs, and as shown in the table by 

highlighted cells, there were many significant differences between the three scorers even though the 

average differences were small. The results of Morpheus were significantly different from both M1 and 

M2 in 8 variables (solid shade and diagonal stripes). MICHELE Auto-scoring was different from both S1 

and S2 in five. As in the case of the MICHELE, the authors of the Morpheus study (2) commented on the 

occasional inaccuracy of the Morpheus system in estimating REM-onset latency. They indicated that 

Morpheus missed the first REM period in 10 patients (32%) whereas MICHELE missed the first REM 

period in only one patient.  The differences they reported between manual and automatic scoring in the 

other variables were in the same range as what we observed with MICHELE. Both systems 

underestimated the arousal index. With Morpheus the difference was 11 hr
-1

 (0.5[30+36]-22) while 

MICHELE underestimated the index by 8 hr
-1

 (0.5[32+33]-25). The correlation coefficients for 

comparisons between manual and MICHELE’s scoring (S1 vs.Auto and S2 vs. Auto) exceeded the 

corresponding coefficients in the Morpheus study (M1 vs. Auto and M2 vs. Auto) in all categories except 

the Arousal Index, where it was only marginally lower. The averages of all correlation coefficients for the 

comparisons between Tech.1 & Tech.2, Tech.1 vs. Auto and Tech.2 vs. Auto are given at the bottom of 

the table. There were no significant differences (by ANOVA for repeated measures) between the three 

averages in the case of MICHELE. 
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Table 4                         

Comparison between Michele and Morpheus for Scoring Clinically Relevant Variables 

       Michele Auto-Scoring System                Morpheus       

Variable       
S1 
vs. 

S1  
vs. 

S2 
vs.       

M1  
vs. 

M1  
vs. 

M2 vs. 

  S1 S2 Auto S2 Auto Auto M1 M2 Auto M2 Auto Auto 

Total sleep time (min)  330 300 312 0.876 0.934 0.968 348 345 357 0.980 0.920 0.940 

SD 73 76 72     63 61 65     

Sleep efficiency (%) 79 72 75 0.883 0.941 0.968 83 82 85 0.960 0.870 0.910 

SD 16 18 17     12 11 12     

Sleep-onset latency (min)  22 25 24 0.98 0.94 0.95 26 26 22 1.000 0.860 0.860 

SD 27 27 29     24 24 21     

REM-onset latency (min)  131 121 126 0.92 0.90 0.92 130 127 175 0.990 0.460 0.460 

SD 72 71 73     79 74 81     

Stage wake (min) 91 120 108 0.886 0.942 0.969 85 89 76 0.960 0.870 0.910 

SD 72 80 74     49 46 50     

Stage 1 (min)  52 44 42 0.692 0.731 0.804 19 49 38 0.220 0.370 0.530 

SD 40 29 28     15 20 27     

Stage 2 (min)  167 168 159 0.925 0.926 0.822 231 222 214 0.800 0.840 0.720 

SD 57 57 50     54 46 48     

Stage 1+ 2 (min) 219 212 202 0.830 0.903 0.811 250 270 252 0.860 0.870 0.730 

SD 62 61 62     55 53 59     

Stage delta (min)  55 36 60 0.671 0.967 0.548 38 21 50 0.570 0.530 0.180 

SD 43 36 46     26 23 26     

Stage REM (min)  55 51 51 0.948 0.953 0.915 60 53 55 0.920 0.720 0.760 

SD 28 25 26     30 26 34     

Arousal Index (events/h) 32 33 25 0.875 0.594 0.461 30 36 22 0.810 0.720 0.580 

SD 18 24 11     19 17 16     

PLM Index (events/h) 11 12 13 0.849 0.959 0.738 13 16 19 0.930 0.610 0.650 

SD 31 32 31     19 21 25     

Resp. Disturbance Index         21 23 24 0.990 0.950 0.950 

SD         23 25 23     

AHI A (events/h
-1

) 30 28 32 0.947 0.985 0.930         

SD 40 41 40             

AHI B (events/h
-1

) 34 31 29 0.932 0.967 0.926         

SD 43 43 37                   

Average       0.872 0.903 0.838       0.845 0.738 0.706 

             

   Significantly different from Auto.  Significantly different from Tech.2.  

  Significantly different from both Tech. 2 and Auto.    
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2.0 Viewer Installation 

 

2.1 Instructions 

 

Follow the instructions below to install the Viewer. (Instructions on the software update process are 

provided in Section 2.3.) 

 

Note 1: During the install process, if a Windows pop-up asking if ‘filename.exe’ is 

allowed to make changes to this computer, ‘Yes’ must be selected to enable the 

installation. 

 

Note 2: For the Windows XP 64-bit operating system, the following items need to be 

installed before successful installation of the Viewer: 

 

 Microsoft .net Framework 3.5 

 A Microsoft patch entitled ‘wic_x64_enu’, that should look like this:  

 

The patch can be downloaded by pasting this url into your web browser:  

http://www.microsoft.com/en-us/download/details.aspx?id=1385 

 

To initiate the software installation process, double click on the “MICHELE_vX_XX_XXX.exe” icon, 

shown below, which is provided as part of the Viewer software distribution.  

 

Figure 2.0 
  

Depending on your settings, one or more “Open File – Security Warning” windows such as the one 

shown below in Figure 2.1 may appear after initiating the installation process.  In each instance, select 

Run.  A Microsoft Windows message may appear asking if you want to allow the following program 

from an unknown publisher to make changes to this computer.  The program is: 

“MICHELE_vX_XX_XXX.exe”, where the X represents specific version numbers of the software.  

Select Yes if you wish to proceed with the installation.   

A window will appear asking if you want to install the MICHELE Data Viewer as shown in Figure 2.1 

below.  Select Yes to proceed with the installation. 
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Figure 2.1 

 

 

 

 

A WinZip Self-Extractor will appear as shown in Figure 2.2 and will begin unzipping the following 

programs that are required for Viewer operation:  

 Microsoft .NET Framework 4; 

 Microsoft Visual C++ 2010 x86 Redistributable.  
 The MICHELE Sleep Scoring System Viewer (titled “YST Data Viewer”) 

 
 

 

 

 

 

 

 

 

 

 

 

Figure 2.2 

 

If the target PC has all of the above-listed programs installed, the Viewer Setup Wizard shown in Figure 

2.8 will appear.  If the target PC does not have all of the above-listed programs installed, the Viewer setup 

process will attempt program installation automatically.  In each case, the user will be required to read 

and accept license terms, and confirm installation.  For example, if the target PC does not have 

Microsoft® .NET Framework 4.0 and Microsoft® Visual C++ 2010 installed, the following Viewer 

Message as shown in Figure 2.3 may appear.   
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Figure 2.3 

Select Accept.  A Microsoft window will appear asking the user to accept the install of the .NET 

Framework. Once Accept has been selected, the Viewer Setup window shown in Figure 2.4 will appear. 

 

Figure 2.4 

Select Install.  This installs the Microsoft® Visual C++ 2010 component libraries.  If this does not happen 

automatically – i.e. if the window as shown below in Figure 2.5 does not appear – run the installation 

manually after completing the Viewer software installation by double clicking on the file 

“vcredist_x86.exe” that was included in the Viewer installation package and proceed as described below. 
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Figure 2.5 

Click on the “I have read and accept the license terms” checkbox, and then click on the Install button.  

The installation progress will be displayed as shown below in Figure 2.6. 

 

Figure 2.6 

You will be greeted with a Windows Installer message asking if you want to allow this program to make 

changes to the computer at which time you will need to select Yes to continue with the installation.  

Another Windows message will appear asking the same question, quoting file 

“dotNetFx40_Full_x86_x64.exe.”  Select Yes.  After the Microsoft® Visual C++ 2010 component 
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libraries are installed, the installer will automatically install the .NET Framework. The window shown in 

Figure 2.7 will be displayed while it is being installed.  

 

Figure 2.7 

The Viewer Setup Screen will open up next, as shown in Figure 2.8. Select Next.  

 

Figure 2.8 

If a window displaying a License Agreement opens, as shown in Figure 2.9, read the agreement and select 

“I Agree” then Next to proceed with the installation.  Note that the License Agreement may not be written 

as shown in Figure 2.9, and furthermore, may be provided as a separate document that the end user must 

sign and return to YST prior to being able to complete the installation of the Viewer.  
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Figure 2.9 

For the installation folder dialog, shown in Figure 2.10, it is recommended to choose “Everyone” and to 

keep the default location as is for all installations.  Choosing “Everyone” will allow any user account on 

the computer to access the YST Viewer.  Choosing “Just me” will only allow the YST Viewer to be 

utilized by the same account used in installation. 

 

Settings for the YST Viewer are kept individually when “Just Me” is selected during the installation.  If 

the installation is for “Everyone,” the following information will be accessible to all users: montages; 

login information; documentation; downloads; report templates; and software update information 

including version identification.  
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Figure 2.10 

After selecting the installation folder, a Confirm Installation dialog will be shown next as per Figure 2.11.  

Select Next to proceed. 

 

Figure 2.11 

You will then see a progress bar indicating the installation status as shown in Figure 2.12 below. 
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Figure 2.12 

The Viewer should then appear as an icon on the desktop, as shown in Figure 2.13. 

 

Figure 2.13 

Do not attempt to start the Viewer yet.  Continue with the installation process described below. 
 

As described earlier, the Viewer setup process will attempt to automatically install each program that is 

required to use the Viewer.  To determine whether the programs have installed automatically, go to “Add 

or Remove Programs” in the Control Panel and review the “Currently installed programs” list to 

determine whether all four are listed (as per the list shown earlier, and below).  Any program that is not 

listed will need to be installed from the Viewer installation disk.  If a program needs to be installed in this 

manner, it will be necessary to determine whether the operating system on the target PC is 32-bit or 64-

bit, in order to access the appropriate folder on the installation disk – either the folder labelled “32 Bit” 

for a 32-bit system, or the “64 Bit” folder for a 64-bit system.  Within the appropriate folder, there will be 

additional folders that correspond to the four programs, as follows: 

 Folder “DotNetFX40” for Microsoft .NET Framework 4; 

 Folder “vcredist_x64_x86” for Microsoft Visual C++ 2010 x86 Redistributable.  

In each case, there is either a *.exe or a *.msi file that must be used to install the program.  Any file name 

referencing “x64” is to be installed on a 64-bit operating system, and a file name referencing “x86” is to 

be installed on a 32-bit operating system.  
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The only way to confirm the correct installation of Microsoft .NET Framework 4 and Visual C++ 

Runtime Libraries is to check “Add or Remove Programs” in the Control Panel and verify that: 

 Microsoft .NET Framework 4 

 Microsoft Visual C++ 2010 x86 Redistributable  

 

are listed under “Currently installed programs”. 
 

The Viewer installation can be confirmed by checking the status of currently installed programs as 

described above and by successfully executing it as described in the remainder of this User Manual. 

The Viewer is ready to be launched.  To launch the Viewer, either double click on the Viewer icon shown 

in Figure 2.13 above, or access the Viewer through the Windows Start menu (on the lower left-hand 

corner of the desktop screen of any Windows PC), where the Viewer should be contained within a folder 

labeled “YST Limited” which also contains shortcuts to the uninstaller, the release notes, and the User 

Manual.   

When the Viewer is launched for the first time, you will be prompted to provide a Client ID and a 

Password, all of which will be provided by YST.  Figure 2.14 below shows the dialog box where you 

enter the information. 

2.2 Login Information 

 

 

Figure 2.14 



  User Manual – MICHELE Sleep Scoring System 
    

  Revision: 23 
  Effective Date: 04-Nov-14 
  Document Number: YST-UDoc-USM-23 

To be used with Viewer version 1.02.043, 1.02.044 and 1.02.046 
 

 

30 

If your sleep management facility utilizes a proxy server, click on the box beside “I require connecting 

through a proxy server” (shown in Figure 2.14) and the menu box will expand for the user to enter the 

relevant information as shown below in Figure 2.15. 

 

Figure 2.15 

Once your information has been entered, select the “Verify” option.  If “ Do this Later” is selected, the 

Viewer will still launch, but an error message will appear from the Remote File Manager within the 

Viewer indicating it could not connect to YST Servers.  The Viewer is still functional but features such as 

Scoring and Automatic Updates will not function. Scoring is discussed later in this manual.  Automatic 

Updates are discussed in the following section. 
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2.3 Software Update Instructions 

YST will update its Viewer software and associated components on a regular basis.  Users have the option 

of receiving updates automatically or manually checking for updates, via the Preferences Menu (Figure 

2.16) of the Viewer Main Menu as described in Section 3 of this User Manual.  The default selection is to 

receive automatic updates, as described below.   

 

Figure 2.16 

When new updates are available, you will be notified on the Splash Screen when the Viewer has been 

opened as shown in Figure 2.17 below. 

 

Figure 2.17 

The update will start downloading automatically and will be indicated by an alert in the user’s bottom 

right corner of their monitor, as shown in Figure 2.18 below. 
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Figure 2.18 

Once the update has finished downloading, a window will appear on the user’s monitor as shown in 

Figure 2.19 below.  Select “OK” and close the Viewer.  Users will notice a window appear asking if they 

wish to install the new Viewer.  Select “Yes”, and the installation of the new Viewer will commence.   

 

Figure 2.19 

Figure 2.20 below shows the software gathering information about the current version and tools that are 

currently loaded on the computer. 

 

Figure 2.20 
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Figure 2.21 below shows the window that will appear when the software is about to remove the old 

version of the Viewer. 

 

Figure 2.21 

Notice the continuation of the two status windows shown in Figures 2.20 and 2.21 above, and their 

progression.  This is normal during the upgrade process. 

In Windows® 7, Windows Vista® and Windows® XP a window will pop up asking you to approve the 

installation of the software. Select Yes to proceed. 

Once Yes has been selected, the Viewer Setup Wizard Window will appear as indicated below in Figure 

2.8 above. Select Next to proceed.  The installation of the new Viewer will follow the steps shown in the 

original install procedure, indicated between Figures 2.8 and 2.12 above. 

As shown in Figure 2.22a below, a final status window will appear.  This window provides the user the 

option of viewing the release notes pertaining to the update installed.  When “View Release Notes” is 

selected, the release notes will appear as shown in Figure 2.22b below.  Referring again to Figure 2.22a, 

once Close is selected, the window will disappear (If the Release Notes window shown Figure 2.22b was 

open, Close must be selected in that window prior to selecting Close in the status window shown in 

Figure 2.22a.).   

 

Note: With respect to release notes, once the Viewer has been installed, the release notes 

can be accessed by selecting the appropriate menu items within the Help Menu, as 

described in Section 7.  

 

Users will need to restart their Viewer at this point in order to use it.  All scored studies and saved 

montages will remain intact and available to use again. 



  User Manual – MICHELE Sleep Scoring System 
    

  Revision: 23 
  Effective Date: 04-Nov-14 
  Document Number: YST-UDoc-USM-23 

To be used with Viewer version 1.02.043, 1.02.044 and 1.02.046 
 

 

34 

 

Figure 2.22a 

 

Figure 2.22b 

On rare occasions, critical software updates may be required.  End users are required to implement these 

updates immediately. End users will receive a message that an update is available via the Splash Screen 

within the Viewer when a critical update is required.  A window will also appear as shown below in 

Figure 2.23. 
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Figure 2.23 

If the user decides to ignore this message by selecting the “X” (closing the window) they will notice that 

several functions within the main File Menu will be disabled as shown below in Figure 2.24. 

 

Figure 2.24 

The greyed out menu items are no longer functional and will remain disabled until the critical update is 

installed.  The user may exit the Viewer and reopen it, selecting “OK” to update their version of the 

Viewer when the message box shown in Figure 2.19 appears.  The normal software update proceeds as 
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described throughout the Software Update Instructions information of this User Manual (Section 2.3).  

The release notes pertaining to the critical update can be reviewed also as described earlier in this section 

(Figures 2.22a and 2.22b). 

 

2.4 Creating Proper Score File Directories 
 

It is necessary to store all EDF/REC files in separate folders.  Keeping them together in one folder will 

corrupt the scoring data. 
 
Create a folder on your hard drive called YST Data Files.  It can be anywhere, as long as it’s NOT under 

the newly installed YST Limited folder.  Within the YST Data Files folder, you will need to create 

subfolders for each individual study (using a patient’s name or subject code) to store all of your 

individual EDF/REC files (Figure 2.25). 

 

 

 

Figure 2.25 
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3.0 Setup and Use of the Main Graphical User Interface Window 
 
3.1 How to Customize the Main Window Layout 
 
Once the Viewer is launched, the Main Graphical User Interface (GUI) Window will be shown as per 

Figure 3.0. 

  

 

 

 
 

 

 

Figure 3.0 
 
 
Note that in Figure 3.0, there is no file open.  Subsequent figures (Figure 3.1 and onward) show images 

from open, scored files.   

 

The main GUI window has the potential to be customized extensively.  There are four main ways to 

display the four major windows numbered 3 through 6 in Figure 3.0: 

 Docked 

 Tabbed 

 Floating 

2. Toolbar 
1. Main Menu 

4.  Properties 

Window 

5.  Scoring 

Window 

6. Hypnogram 

3.  Graph 

Window 
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 Collapsed (does not apply to Graph Window) 

 

Docked is the term used to indicate that a window has a fixed place on the screen entirely unto itself.  

Dragging the edges of a docked window will resize all docked windows that are adjacent to the window 

being dragged.  In Figure 3.0, all four windows are displayed in the Docked mode. 

 

Tabbed is the term used to indicate that two or more windows share the same fixed place on the screen. 

Resizing of the shared space has the same results as resizing a Docked window.  

 

The following Figure 3.1 displays a tabbed window hosting both the Scores Window and the Properties 

Window. 

 

 
 

 

Figure 3.1 

 

The tabs in the Viewer are located at the bottom of the window.  Clicking on a tab will switch the display 

in the tabbed window. 
 
Floating is the term used when a window does not have a fixed place on the screen.  Resizing a floating 

window does not affect any other window.  Figure 3.2 below shows an example of a floating window.  In 

this example, the Scores Window is floating. 

 

Tabs 
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Figure 3.2 

 

A floating window can be placed anywhere on the screen – it is not confined to being located within the 

main interface window. 
 

To Collapse a window, clickon the pin icon ( ) in the top corner of a docked or tabbed window.  Figure 

3.3 shows the Hypnogram window collapsed, and Figure 3.4 shows the Hypnogram window docked. 
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Figure 3.3 

 

 
 

Figure 3.4 

 

To display a collapsed window, the mouse must be placed over top of the tab (in this case, the tab says 

“Hypnogram” – bottom left corner of Figure 3.3).  This will cause the window to appear.  To keep the 
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window from re-collapsing, dock the window by either clicking on the pin icon or clicking anywhere 

within the window. 

 

If the window is not selected or pinned, it will once again become collapsed when the cursor is removed 

from the area it occupies. 

 

To change the state of a window (the Selected Window), click on the window name and drag the mouse.  

This will detach it from the current Docking point and will present you with many sets of display options. 

 

 
Figure 3.5 

 

Figure 3.5 shows the five major docking options.  While still holding the mouse down, drag the cursor 

over one of these options and then release the mouse.  The options are as follows: 

 Docks the Selected Window above the current window (shares a horizontal boundary) 

 Docks the Selected Window to the left of the current window  (shares a vertical boundary) 

 Docks the Selected Window below the current window (shares a horizontal boundary) 

 Docks the Selected Window to the right of the current window  (shares a vertical boundary) 

 Tabs the Selected Window with the current window (shares all boundaries) 

 

The “current window” refers to the window over which Figure 3.5 appears.  Figure 3.6                                    

illustrates this phenomenon. 
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Figure 3.6 

 

In Figure 3.6, the Properties Window is currently being dragged.  Since the mouse is currently being held 

over top of the Scores Window, docking options are presented over top of the Scores Window.  Selecting 

one of these options will apply the docking options described above using the Scores Window as the 

current window.  Selecting the tabbing option causes both the Selected Window and the current window to 

become tabbed. 

 

You will also notice a second set of docking options presented – those located along the edges of the 

screen and lacking the tabbing option.  Using one of these options will dock using the main interface 

window as the current window. 

 

If no docking option is selected, the window switches to the floating state. 

 

The default layout can be viewed at any time by selecting ’View’ from the main menu and then 

selecting ‘Default Layout’. 
 
3.2 The Main Menu 
 
The Main Menu is composed of five sub menus.  These are the File Menu, the View Menu, the 

Configuration Menu, the Preferences Menu, and the Help Menu.  The File Menu is discussed below.  The 

View Menu is discussed in Section 5.7; the Configuration Menu is accessed as discussed in Sections 3.7, 

5.3, and 5.6; and the Help Menu is discussed in Section 7.    

 

The File Menu is used to access and manipulate high-level functionality of the application. 
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Selecting Open Patient File brings up a dialog box in which a patient file can be selected.  The patient file 

must be encoded as an EDF file; the file extension is irrelevant provided the EDF syntax is followed.  

Opening a patient file automatically opens all .ev (scoring) files located in the same directory as the 

selected patient file.  

 

Close Patient File closes the currently opened patient file and provides an opportunity to save changes to 

different components of the system. 

 

Channel Information shows a small dialog box that presents three aspects of the opened file, the channel 

numbers, names and sample rates.  This is displayed in Figure 3.7. 

 

 
Figure 3.7 

 

The Save function can be utilized to save a montage, an edited file (current working copy), or analysis 

notes that accompany a file.  

 

The Score File Manager is described in Section 5.3. 

 

Montage Manager displays a dialog that lists all of the current montages.  For more information on 

montages, including importing and exporting thereof, see Section 3.9. 

 

See Section 4.2 for details on selecting Score File from the File Menu. 

 

The Remote File Manager is described in Section 4.5. 

 

How to generate a report using the Generate Report option is covered in detail in Section 6 of this 

manual. 

 

The Print option allows printing of any of the Graph Window, Hypnogram, Event List or Analysis Notes. 
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The Recent File List displays a list of recently opened files.  Selecting a file from this list is the equivalent 

of utilizing Open Patient File. 

 

Exit attempts to close the application, first prompting to save changes. 

 

3.2.1 Opening a Patient File 
 

To open a file, go to the File Menu and choose “Open Patient File”. 

 

 
 

Figure 3.8 

 

Note: Each EDF file should have a unique file name that does not include any 

identifiable patient information.  EDF files that have been scored should never be re-

named. 

 

You should see a screen similar to the one shown below in Figure 3.9.  Note that the hypnogram and 
scoring pane are blank as there is no scoring associated with this file yet. 
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Figure 3.9 
 

Once a study has been opened in the Viewer, it will be necessary to build a new montage by setting 

up each individual channel, all properties/settings within, and the Channel Mappings.  If channels 

numbers are ordered differently between collection systems or rooms/beds, a montage will have to 

be built and saved for each configuration of channels.  Once a montage has been saved, it will not 

have to be built again and can just be chosen for each related study. 

 
Right clicking in the Channel Header Area brings up a channel selection menu shown in Figure 3.10 

below. 
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Figure 3.10 

 

This menu allows for adding and removing channels from the graph window.  Any channel with a 

checkmark is currently visible.  By selecting a channel from this list, the visibility is toggled: if a 

currently hidden channel is selected, it is added at the location of the mouse; if a currently visible channel 

is selected, it is hidden and no longer shown in the graph window. 
 
To change the vertical position of a channel, click to select a channel, and then while holding down the 

mouse, drag it up and down.  
 
To remove a channel from the graph window, select the channel and then press the delete key.  To have 

the channel shown again, right click in the Channel Header Area and select the channel. 

 

The bottom of the Channel Header Area displays the time of the cursor both in real time and in seconds 

past the start of the file. 
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3.3 Setting Up Individual Channels and All Properties Within 
 
Once all desired channels have been selected and displayed according to your preferred layout, you will 

need to set the properties for individual channels. 

 

3.3.1 Properties Window 

 

The Properties Window is used to control the properties of all components in the main user interface 

window. 

 

The following have properties: 

 Graph Window 

 Graph Channels 

 Individual Events 

 Hypnogram 

 Hypnogram Channels 

 

To access the properties of any of the above items, they must first be selected.  The different properties 

windows are placed in the same frame of the user interface (the default layout has the properties window 

in the top right portion of the screen), and the contents are changed depending on which item is selected. 

 

3.3.2 Graph Window Properties 

 

 
Figure 3.11 
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To select the Graph, click anywhere in the Graph Window except on a channel name or an event.  The 

only customizable properties of the Graph Window involve how the graph is colored, as shown above in 

Figure 3.11. 

 

The Background color sets the color of the background. 

The Primary Line color sets the color of the dashed vertical lines. 

The Secondary Line color sets the color of the solid vertical lines. 

The Epoch Divider color sets the color of the epoch divider line. 

The Sleep Stage color sets the color of the sleep stage lettering. 

The Lights Tag, Body Tag, CPAP Tag, BiPAP Tag, Oxygen Tag and Notes Tag colors set the color of the 

tags that can be placed in the Graph Tray 

Stage Display Type changes the position of the Sleep Display which appears in the background of the 

Graph Window, indicating the sleep stage that was scored for the currently viewed 30-second epoch.  

Selecting “Top” will allow the sleep stage to appear on the top of the Graph Window, selecting “Bottom” 

will display the sleep stage on the bottom of the Graph Window, and selecting “Both” will display the 

sleep stage on both the top and bottom of the Graph Window.  

 

To modify sizing of the graph window, the borders may be clicked and dragged. 
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3.3.3 Graph Channel Properties 

 

 

 
 

Figure 3.12 
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To view or change the individual channel properties, click on the channel in the Channel Header Area.  

The graph channel properties are separated into seven categories, as shown in Figure 3.12.  Those 

properties are described below.  The Appearance, Channel Data, Numeric Display, Position, and Scale 

categories apply specifically to the display of channels in the Main Window and the settings do not have 

an impact on scoring.  The Events category will not impact scoring but may be used to set default events 

that will allow for Quick Mode editing described in Section 5.  Settings made in the General category 

will affect autoscoring, and are therefore described in this section as well as Sections 3.4 and 3.5. 

 

The Appearance category allows adjustment of how the channel is graphically represented. 

 

The Color property sets the color of the channel and any events placed on it. 

 

The Visible checkbox is another way to hide a channel.  This cannot be used to make a channel visible, as 

the channel properties window is only visible when a channel has been selected. 

 

The Channel Display displays the visible channels for the specified time window.  It also displays all 

events at the appropriate start time with the appropriate duration and name.  

  

The Channel Data category enables the display of extra-numerical information about the channel in the 

Channel Info Area.  Often used with the SaO2, CO2 and CPAP pressure channels, the values appear at 

the right side of the channel in the Graph Window. 

 

The Display Min checkbox displays the minimum value of the current window. 

The Display Max checkbox displays the maximum value of the current window. 

The Display Avg checkbox displays the average value of the current window. 

 

The Numeric Display category allows you to modify numeric values displayed within a channel across 

the Graph Window.  Numeric display modifications are available to all channels within the Viewer. 

 

The Show numerics box activates the numeric entries chosen across the channel horizon within Graph 

Window. 

The Numerics to show box is where you enter the amount of numerics to show across the channel 

horizon. Example:  Entering 10 would show 10 numeric values within the current window horizon of the 

channel. 

The Decimal box is where you would enter the number of decimal places to be shown for the numeric 

values.  

 

 
Figure 3.13 

 

Figure 3.13 shows a Numeric display for the SaO2 channel with 10 values and zero decimals selected.  

 

The Events category allows creation of events on this channel.  This may be done for scored files only.  

Refer to Section 5.0 for description of the creation of events. 
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Default Event determines the default event created for the selected channel.  Once a default event is 

created, it can still be altered manually.  The events that can be created using this function are: 

 A (Arousal) 

 Apnea (unclassified) 

 Arrythmia 

 Asystole 

 Atrial Fibrillation 

 Bad Oxygen (Bad Oxygen Section) 

 Bradycardia 

 Bruxism 

 C (Central Apnea) 

 Desat (Desaturation) 

 H (Hypopnea) 

 HO (Obstructive Hypopnea) 

 M (Mixed Apnea) 

 Narrow Complex Tachycardia 

 O (Obstructive Apnea) 

 PLM 

 REM Behavior Disorder 

 RERA 

 Rhythmic Movement Disorder 

 Sinus Tachycardia 

 Snore 

 UNKNOWN EVENT 

 Wide Complex Tachycardia 

 

The Default Duration property allows setting the duration of default events.  The default events can be 

added to scored files using the Quick Mode of editing described in Section 5.3, and the duration can be 

modified (also as described in that section). 

 

The Position category in the graph channel properties window (Figure 3.12) deals with how the channel 

is positioned on the screen. 

 

The Height % option allows for specifying how much of the Graph Window, as a percentage of the total 

height, the channel should occupy.  The value entered here must be greater than 0, and less than or equal 

to 100.  Invalid entries are rejected. 

 

The Y % option allows for specifying where on the Graph Window, as a percent of the total height, to 

place the top of the channel.  The value entered here must be greater than 0 and less than 100.  Note that if 

Y% + Height % is greater than 100, part of the channel will be clipped by the Graph Tray. 

 

Alternatively, dragging the channel up and down as described earlier in the Channel Header section can 

modify the Y % option. 
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The Scale category deals with how the channel data is represented inside the physical space specified by 

the Height % and Y % settings. 

 

Note: The descriptions of the Upper Limit and Lower Limit apply to a non-inverted 

signal.  For an inverted signal, switch the definitions of Upper Limit and Lower Limit. 

The description of Auto Scale must also be adjusted by switching Upper Limit with Lower 

Limit. 

 

The Upper Limit option sets the upper limit of the channel, defined as the maximum value that will be 

visible in the graphical representation of the channel.  Any value that is above the upper limit will be 

clipped for display purposes to be equal to the upper limit. 

 

The Lower Limit option sets the lower limit of the channel, defined as the minimum value that will be 

visible in the graphical representation of the channel.  Any value that is below the lower limit will be 

clipped for display purposes to be equal to the lower limit. 

 

Upper and lower limits will need to be entered for all AC channels and for the DC channels that show 

numerical values such as SaO2, CO2 and CPAP pressure. 

 

Examples for various channels of settings in the graph channel properties window are shown in Figure 

3.14 below. 
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Figure 3.14 

 

In the Scale category, the Auto Scale checkbox enables and disables auto scaling.  When auto 

scaling is enabled, the Upper Limit is automatically set to the maximum value in the current 

window, and the Lower Limit is automatically set to the minimum value in the current window.  

When Auto Scale is checked, the Upper Limit and Lower Limit cannot be modified. 

 

Auto scaling automatically updates the limits each time the displayed data is changed in any way. 

 

It is recommended to check the Auto Scale box only for Chest, Abdomen, Thermistor, Nasal 

Pressure and CPAP Flow.  Make sure not to check the Auto Scale box for the channels that you 

have entered upper and lower limits for, such as the EEG and SaO2 channels.  See Figure 3.15 

below. 
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Figure 3.15 

 

 

The General category deals with signal processing functionality that can be applied to a specific channel. 

 

The Invert Signal option allows for a signal to be represented as either Positive Up and Negative Down 

(non-inverted), or Negative Up and Positive Down (inverted).  Clicking on the Invert Signal checkbox 

will automatically invert the limits entered (see Scale).  Specifying an upper limit that is lower than the 

lower limit will automatically invert the signal.  While the EEG and EOG channels should be inverted for 

every patient file, within individual studies certain signals such as EKG and thermistor may need to be 

inverted for correct polarity as well. 

 

The Grid Lines option can be utilized to draw dashed horizontal grid lines on a selected channel.   An 

example of grid lines, set at 37.5 and –37.5, appears in Figure 3.16.  These grid lines enable the user to 

easily see the size of a 75uv Delta wave.  

 

 

 
Figure 3.16 

 

Selecting the Grid Lines option presents the dialog box shown in Figure 3.17 
 

 
 

 

Figure 3.17 

 

Here, the levels at which grid lines are displayed are listed in the Level box.  To add a new grid line, click 

on the Add button, which will display the window shown in Figure 3.18. 
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Figure 3.18 

 

To delete a grid line, select the level from the list shown in Figure 3.17 and press the Delete button. 

 

Grid lines can be used for other channels besides EEG, like SaO2, CO2 or CPAP pressure.  Figure 3.19 

provides an example of grid lines on the SaO2 channel. 
 

 
 

Figure 3.19 

3.4 Filters 

 

The Filters option allows for different filters to be applied to the selected channel.  Low and high filter 

settings will need to be applied to all AC channels (i.e. EEG, EOG, EMG and EKG).  It is not necessary 

to apply filters to the DC channels (e.g. flow).  The maximum high frequency filter setting cannot exceed 

that of half of the collection sampling rate.  Selecting this option in the General category of the graph 

channel properties window (see Figure 3.12) opens a filter management dialog box shown in Figure 3.20. 
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Figure 3.20 

 

Select the box next to the filter frequency you wish to enter and type in the numeric value to be applied. A 

Notch Filter can also be selected, with an allowance for either a 50 Hz or 60 Hz setting to accommodate 

the variability between geographical regions. Figure 3.21 below displays the end result of entering filter 

settings. 

 

 
Figure 3.21 

 

Note that the green check marks appear if the numeric values you entered are allowed for the frequency 

filter selected. If a non-appropriate value is entered, a red X will appear beside the box indicating that the 

values need to be revised. Once entries have been accepted, select OK to save your selections, thereby 

applying the filters to the channel selected.  

 

3.5 Referencing 

 

The Reference Channel option in the General category of the graph channel properties window (see Figure 

3.12) allows for referencing to be applied to a given channel.  Referencing each of the AC channels is 

required unless the channels are already referenced when exported.  It is recommended to export the 

channels unreferenced when possible to allow for re-referencing within a study during subsequent viewing 

and editing.  Some data acquisition systems such as Alice 5 export all channels referenced automatically.  

The channels are displayed in the channel header area.  If the channel already has a reference, an example 

of the display shown would be C3-A2 (or C3-M2).  If C3-A2 is displayed, it is known that the channel was 

exported referenced.  If each signal is displayed separately, i.e. C3, A2, M2, Right EOG, Chin EMG 1, Chin 

EMG 2, etc., that means the channels were exported un-referenced and references will need to be applied 

for all AC channels within the montage.  When references are applied either during the export or when 

setting up the montage, the channel will be displayed showing the reference in the channel header area, i.e. 

EMG1-EMG2 or C3-A2. DC channels such as flow do not need to be referenced.  By selecting the 

Reference Channel option, the referencing dialog box is opened, shown in Figure 3.22.  Referencing a 

channel to another channel is the equivalent of subtracting the referenced channel from the original channel, 

potentially removing common artifacts. 
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Figure 3.22 

 

The channel reference dialog is split into two sections.  One is the Channel List, which shows a list of all 

channels in the opened patient file; the other, the Reference Channels list, shows all the channels that are 

currently being used for referencing. 

 

To add a channel to the Reference Channels List, first select it in the Channel List, and then press the 

right arrow button [>].  To remove a channel from the Reference Channels List, select it in the Reference 

Channels List and press the left arrow button [<].  The up and down arrows can be used to move channels 

up and down in the Reference Channels List, although this has no impact on the results. 

 

If more than one channel is selected for referencing, the average of the selected channels is calculated and 

used as a single reference channel. 

 

Note: For referencing to function properly, the selected channels must have the same 

sampling rate as the current channel.  If any channel that is added to the Reference 

Channels List does not have the same sampling rate, it is simply ignored. 
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3.6 Channel Renaming 

 

The Viewer allows you to rename each channel within the Graph Window.  The renaming can be either a 

temporary or permanent change to the .EDF file.  To change a channel name, right-click on the channel 

name and a message box will appear as shown in Figure 3.23 below. 

 

 

 
Figure 3.23 

 

By clicking on the dialog box called Rename Channel, another dialog box will be displayed requesting a 

new name to be entered (shown below in figure 3.24). 

 

 
 

Figure 3.24 

 

Once the name is entered, select OK for the change to take place.  You will be presented with a new 

dialog inquiring as to whether the change is to be temporary or permanent (see Figure 3.25). 
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Figure 3.25 

 

Selecting ‘Yes’ will permanently modify the EDF File, while selecting ‘No’ will only modify the current 

viewing of the file. Once the file is closed, any temporary name changes will be lost. 

 

3.7 Hypnogram Properties 

 

 
 

Figure 3.26 

 

Selecting the hypnogram is done in a manner similar to selecting the graph.  The only configurable 

property of the hypnogram is the background color, which functions in the same manner as in the Graph 

Window.  This is shown in Figure 3.26. 

 

Selecting a hypnogram channel is performed in the same manner as selecting a graph channel.  There are 

two types of channels that can be displayed in the hypnogram; these are hypnogram-specific channels, 

and generic channels. 

 

The hypnogram-specific channels are: 

 Hypnogram (shows Sleep Staging) 

o Uses a color scheme for displaying sleep stages 

 Awake and stage transitions: Black 

 Stage 1: Orange 

 Stage 2: Red 

 Stage 3: Green 

 REM: Purple 

 Body Position 
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 Leg Movements (shows a tick for each event) 

 Arousals (shows a tick for each event) 

 Respiratory (shows a tick for each event) 

 

Hypnogram-specific channels use the properties window shown in Figure 3.27 (a).  Generic channels use 

the properties window shown in Figure 3.27 (b).  

 

Additional generic channels can be displayed within the hypnogram such as SaO2.  This is done in the 

same manner as adding channels and setting the properties within as in the main window channel header 

area. 

 

 
(a)                                                       (b) 

Figure 3.27 

 

3.8 Body Position Channel 

 

‘Body Position Channel Levels’ (found under the Configuration Menu in the toolbar) is used to extract 

body position information from a body position channel.  If the body position information is stored in a 

channel, voltage levels must be assigned to the different positions that are extracted from the channel.  As 

well, a body position channel must be designated in the Channel Mappings discussed later. 
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Figure 3.28 

 

Selecting a row in the table shown in Figure 3.28 and pressing “Delete” will undo that mapping.  

Checking “Disable Voltage Levels” is the equivalent of temporarily deleting all of the entries. 

 

In order to close the Voltage Ranges dialog box, there must be no conflicts.  A conflict is defined as two 

or more positions having the same voltage mapping, or two or more voltages being mapped to the same 

body position. 

 

Once all channels have been edited to the desired specifications, Channel Mappings need to be assigned. 

3.9 Channel Mapping 

 

In order to properly execute the automated scoring module embedded in the Viewer, the Viewer must 

know which channels within the currently open EDF file contain the primary signals required for 

automated scoring. 

 

To configure the channel mappings, select ConfigurationChannel Mapping in the Main Menu. The 

following window will be displayed as shown in Figure 3.29 below. 
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Figure 3.29 

 

The Channel Type column lists the fundamental channel types required by the automated scoring.  These 

are listed and are the names used by YST.  Channel Name corresponds to the specific channel in the 

current EDF file.  The Viewer cannot automatically correlate specific data channels within the EDF file to 

the required channels necessary for scoring; this must be done manually through the process described in 

this section.  A channel name must be chosen for each individual channel.  If this is not done, YST will 

not be able to distinguish the channel type and will not be able to score the file. 

 

There is a minimum selection of channels required to perform the automated scoring for a Level 1 or 2 

study.  The following channels are required: 

  

1. Two central EEG channels (occipital EEG’s should not be mapped) 

2. EKG 

3. Right EOG 

4. Left EOG 

5. Chin EMG 

6. O2 Saturation 

7. Thermistor 

8. Nasal cannula OR CPAP flow signal 

9. Chest and abdomen bands 

10.  Right and Left Leg EMG if PLM scoring is required 
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However, to improve scoring accuracy, all of the channels in the Channel Type column should be 

included in the EDF file used for automated scoring. 

 

Similarly, there is a minimum selection of channels required to perform the automated scoring for a Level 

3 study. The following channels are required: 

 

1. Thermistor or Nasal pressure (ideally both) 

2. O2 Saturation 

3. Chest and abdomen bands 

 

To improve scoring accuracy, the following channels in the Channel Type column should be included in 

the EDF file used for automated scoring: 

 

1. Audio 

2. EKG 

3. Body Position 

4. Pulse Rate 

 

To map a specific channel type to a channel within the EDF file, select the Channel Name text box with 

the mouse.  When this is done, a drop down box listing all of the channels in the EDF file will be 

displayed.  If a specific channel type exists with the EDF file, select it with a mouse click.  Repeat this 

process for all of the channels specified in the Channel Type list. If some channels do not exist within the 

EDF file, leave the Channel Name as “None”. 

 

The Polarity is used only for the following respiratory related signals: 

 

 1. Abdomen 

 2. Chest 

 3. CPAP Flow (Inspiratory and Expiratory) 

 4. Nasal Cannula 

 5. Thermistor 

 

The polarity of each signal is defined by the nature of the signal values as the patient is inspiring.   

 

Example: If the patient is inspiring and the Abdomen signal is increasing in numerical 

value then the polarity of the abdomen signal is + (positive).  If the patient is inspiring 

and any of the listed signals are decreasing, then the polarity for those channels is 

considered to be – (negative) and should be selected as such. 

 

The polarity of the signals is important for the proper detection of respiratory events.  This will have to 

reviewed with each of these signals in each study.  The polarity will have to be adjusted when the polarity 

of the signal is changed within each individual study prior to sending for scoring. 

 

The polarity also applies to the EKG signal.  The polarity of the EKG signal has a slightly different 

interpretation than the polarity of a respiratory signal.  If the R-Wave Peak contains the most negative 

point, then the polarity should be set to negative.  Figure 3.30 below illustrates this concept. 
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R-wave Peak is the most positive point of the EKG Channel                        R-wave Peak is the most negative point of the EKG Channel 

 

              

(a) Positive Polarity                                                   (b) Negative Polarity 

Figure 3.30 

 

Polarity is not applicable to any other channel and cannot be set. 

 

If the EDF file contains Chest (Thorax) and Abdomen effort bands that use the inductive respitrace to 

produce a signal, check off the box in the upper right hand corner (of the dialog box shown in Figure 

3.29) labeled “Respitrace Inductive”. Do not check this box if the Chest and Abdomen bands use any 

other sensing technology, such as piezoresitive or RIP belts. 

 

If the Audio or Snore signal has been pre-processed such that it is no longer an AC signal and contains a 

smoothed waveform representing the recorded audio, select the “Audio Processed” box.  If you are 

uncertain about the nature of the audio signal leave this box unchecked. 

 

If the Nasal Cannula channel requires processing by the square root function, check the “Process Nasal” 

checkbox.  This is necessary when the Nasal Cannula is strictly measuring nasal pressure without any 

signal processing applied, as the nasal pressure measured is proportional to the square of nasal flow.  It is 

therefore necessary to take the square root of the pressure signal to get an accurate representation of nasal 

flow in such cases.  In most cases nasal root is not used and this box should not be checked. 

 

Checking this box will not affect how data is displayed on the screen, only how the autoscoring 

algorithms treat the signal for the detection of respiratory events. 
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If the EDF file contains a signal representing the end tidal CO2 concentration of exhaled air, verify the 

CO2 units in the drop down box as either % or mmHg. 

 

Depending on which option your sleep lab employs, select criteria A or criteria B (as per AASM 2007 

guidelines) for the automatic detection of hypopneas.  Criteria A is defined as a reduction in airflow 

accompanied by an O2 desaturation of at least 4%.  Criteria B is defined as a reduction in airflow 

accompanied by an O2 desaturation of 3% or an associated sleep arousal.   

 

The Desaturation Interval combo box allows for selection between three search intervals that specify the 

search range for an O2max after a desaturation has been identified.  Changing the search interval may 

change the amount of desaturations called. 

 [-90, 0] looks up to 90 seconds back from a desaturation, and does not look ahead 

 [-60, 0] looks up to 60 seconds back from a desaturation, and does not look ahead 

 [-90, +30] looks up to 90 seconds back and up to 30 seconds ahead from a desaturation 

 

Selecting “Save” after configuring all of these parameters will allow them to be saved in the current 

montage file when the montage is saved.  Section 3.9 describes montages. 

 

3.10 Montages 

 

The montage is a collection of settings, including all channel settings as well as the channel mapping 

information described in Section 3.2.  By storing the channel settings, the montage effectively stores the 

way the Graph Window is organized and how the data are displayed.  Montages are handled via the 

toolbar through the Montage Selector. 

 

3.10.1 Creating a new Montage 

 

There are two ways to create a new montage.   

 

The first method involves editing the current montage, and then selecting Save Montage from the File 

Menu.  This will open the window shown in Figure 3.31.  By entering a montage name that does not 

currently exist, the edits will be saved into the new montage, and any old montage will remain as it was 

before the edits were done. 

 

The second method involves immediately saving a new montage.  The new montage can then be edited to 

your liking, and saved by selecting Save Montage and selecting the current montage name in the list. 

 

Selecting Save Montage displays Figure 3.31. 
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Figure 3.31 

 

This prompt allows you to either overwrite a current montage or create a new montage with the current 

settings.  Creating a montage is done by entering a name in the Montage Name box that does not exist in 

the list of current montages. 

 

If all of the data acquisition systems are set up in the exact same way with the same collection system and 

the same channel order and numbering, only one montage will be required which will include one channel 

mapping.  If data acquisition systems are set up differently, different montages/channel mappings will be 

required for each setup.  If the same collection system is used but the channel order or numbering is 

different from one room or system to another, a new montage and new channel mapping within will be 

required for each room or system. 

 

Once a montage has been built for each collection system and/or each room (if the channels were 

numbered or ordered differently from one room or system to another), saving the montage will store it so 

it can be re-opened in the future.  

 

 

3.10.2 Importing/Exporting Montages 

 

Users have the ability to copy a Montage for other Users to import and utilize within their operation.  This 

allows a Sleep lab to create a Montage once and have it used in multiple Viewers within their lab.  To 

import or export a Montage, select the File menu at the top left corner of the Viewer and a drop down 

menu will display as indicated in Figure 3.32 below. 

 

. 
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Figure 3.32 

 

Select the Import/Export Montages, and a dialog box will appear as shown below in Figure 3.33:  

 

 
 

Figure 3.33 

 

If Export Montage is selected the dialog box will be as shown below in Figure 3.34:  
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Figure 3.34 

 

You will need to specify the file location where the montage is to be copied to by clicking on the ‘...’ 

button next to the montage name.  Choose the location and enter the montage file name that you wish to 

export in the file name area.  Click on save.  A box will appear noting that the montage does not exist and 

asking if you want to create it.  Click on Yes.  Once you have selected the location for the montage to be 

saved at, you are returned to Figure 3.34 above but the text box will be filled in with the file path you had 

specified.   

Select the Next  button, and the figure shown in Figure 3.35 below will appear. 

 

 
 

Figure 3.35 

 



  User Manual – MICHELE Sleep Scoring System 
    

  Revision: 23 
  Effective Date: 04-Nov-14 
  Document Number: YST-UDoc-USM-23 

To be used with Viewer version 1.02.043, 1.02.044 and 1.02.046 
 

 

69 

Select the file by clicking on its name, or you can select multiple montages to export by clicking on 

multiple names.  Select finish to complete the process. 

 

To import an existing montage, Figure 3.34 would still appear, but you would be clicking on the ‘…’ 

button to search for a montage that already exists on another PC/Network/File location.  Once you have 

selected that montage file, you are returned to Figure 3.34 again, but with the file path information for the 

montage to be imported specified in the text box.  Click on next. 

 

Highlight the montage or montages you that you would like to import.  Click on next and Figure 3.36 will 

be shown as displayed below.  Click on finish to complete the process. 

 

 
Figure 3.36 

Note:  If you opt to use the Windows Explorer tool outside of the Viewer operation to see 

if the montage files were imported/exported, it will appear that the operation did not 

complete.  In order to see .mon files, the Viewer is required.  Furthermore, if multiple 

montage files were imported/exported, it will appear as if only one file was successfully 

copied.  You should confirm that the transfer was successful by selecting the drop down 

Montage Menu in the Viewer toolbar to review the Montage list available to select as 

indicated below in Figure 3.37.   

 

 
 

Figure 3.37 
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4.0 Scoring a File 

 

4.1 Study Review 

 

It is recommended to review the patient file prior to engaging the scoring process; if the signal quality is 

poor, channels should be re-referenced and the polarity of specific channels inverted if necessary prior to 

sending the file for scoring.  Upon opening the study, ensure the correct montage with the correct channel 

mapping is used. 

 

4.2 Channel Mapping for Scoring 

 

To initiate the process of scoring an opened patient file, select “Score File” from the File Menu.  This will 

initiate dialog (shown in Figure 4.0 below) that inquires about the status of pre-filtering. 

 

 
 

Figure 4.0 

 

Selecting Yes indicates that the primary channels (EEGs, EOGs, and EMGs) have been filtered either by 

hardware filtering, or through software filters applied while exporting the EDF file.  If filters have not 

been applied to these signals during data collection and/or exporting, then select No.  

 

Most systems do not apply the filters in the hardware and most systems do not allow for applying filters 

during the export process.  When the option is given to apply filters during the export process, it is 

recommended not to do so, and to export the study raw, unfiltered and unreferenced.  If these 

recommendations are followed, “No”, should always be selected when the dialogue box above appears. 

 

Note that if the filters which have been applied using the Viewer are the only filters that 

have been applied, No must be selected.  The filters applied within the Viewer are for 

viewing purposes only. 

 

Once this question has been answered, the Channel Mapping window is shown (Figure 4.1 below). 
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Figure 4.1 

 

This window is identical to the one described in Section 3.9, with the addition of five more options. 

 

The first of these new options is the Valid checkbox located on the right side of the window; the second is 

the Referenced checkbox located under the Valid checkbox; the third is the Specify Position and Lights 

button located under the Referenced checkbox; the fourth is the Apply button located beside the Score 

button; and the fifth is the Airway Pressure Scaling Factor. 

 

Once this window is open, the procedure for specifying the information required to enable scoring of a 

file is as follows:  

 Verify that the channel mapping is correct for each individual channel.   

a. Edit it if it is not; 

 Confirm the polarity of the EKG, flow channels, chest and abdomen.  Once all are in phase and 

set correctly within the main viewing window, make note of which channel does not have the 

invert box checked and which channel does have the invert box checked.  For the mentioned 

channels, make sure the polarity within the channel mapping is set to negative for all the channels 

that have the invert box checked.  The polarity should be set to positive for all the channels that 

do not have the invert box checked in the properties area.  If apply is then selected it will save it 

in that study as long the study is open.  
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 Verify that the correct options on the right side of the window are selected. 

a. Check the Respitrace Inductive box if Inductance Plethysmography of any type was used 

for monitoring chest and abdominal movement during the study; 

b. Check the Audio Processed box if audio was used and if it was processed prior to being 

loaded into the Viewer; 

c. Check Process Nasal if nasal root was used with the Nasal Flow. 

 Select Specify Tags and Lights, which will result in the window shown in Figure 4.2 below. 

a. Lights Off and On, as well as CPAP On, can be entered manually in the boxes under the 

Set Time category. 

b. The information can also be imported from a text file.  Select Import Data From File, 

click on the text file related to the study that is open, and select Open. Click on “OK”.  

All the tags such as lights on/off and body position tags will be included in the scoring. 

  The Airway Pressure Scaling Factor feature allows multiplication of the Airway Pressure 

channels (both Inspiratory and Expiratory) to allow for alterations in the gain of these channels. 

This feature was enabled in case files that are exported from data acquisition systems measure 

pressure in units other than cm of water. Where the conversion factor is known, this feature can 

implement the required adjustment. 

 

As indicated above, the Import Data From File button in the Body Position and Lights window (Figure 

4.2) can be used to import a text file with position and lights data, which the user has created.  This text 

file should be created using Microsoft® Notepad (or other software that allows saving as a *.txt file).  The 

file must be encoded in the following format: 

 

Epoch,Event,[extra] 

 

Each event receives its own line in the file.  As long as the first two parameters are present on the line, 

[extra] can contain anything and will be ignored. 

 

Epoch is the 30-second epoch in which to insert the marker, and Event is the event name.  Accepted 

event names are: 

 Lights Off 

 Lights On 

 Out of Bed  

 Upright 

 Right 

 Left 

 Prone 

 Supine 

 Treatment 

 Bi-Level (Level1)/(Level2) 

 CPAP (Level) 

 

These are not case-sensitive; however, any other spelling or event name is ignored.  Spacing is important, 

with one space between each word for the multi-word names. 
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Figure 4.2a 
 

4.2.1 Body Position/Lights Marker Specifics 

 

a.   Body Position channel always overrules supplied tags if it is mapped, as shown in Figure 4.2a 

b.  Pressure tags will overrule a pressure channel assuming the “Use Pressure Tags” box in the 

above window is checked.  This box is checked by default if pressure tags are identified in the file 

(Figure 4.2b). 
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Figure 4.2b 
 

Using a body position channel requires specifying voltage ranges.  If voltage ranges are not specified, the 

default value of Supine is used for the entire file.  See Section 3.8. 

 

 Specifying neither a body position channel nor a body position file will use the markers placed on 

the current events file.  If no markers are placed, the following default values will be used:  

Lights Off will be set to time 0, epoch 1; 

 Lights On will be set to the last epoch; 

 Body position will be set to Supine for the entire file. 

 

4.3 Finalizing User Input Required of Scoring 

 

Once the process of specifying the body position and lights on/off has been completed, proceed to the 

following, remaining steps in the Channel Mapping window (shown in Figure 4.1). 

 Verify that the appropriate channels have been referenced (see Section 1.2.4). 

a. If this had been done prior to exporting the EDF file, check Referenced after verifying 

that no referencing is applied in the Viewer. 
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b. If this was not done prior to exporting the EDF file, apply the proper referencing in the 

Viewer before checking Referenced.  

 Check the Valid checkbox to indicate that everything has been checked and is correct within the 

Channel Mapping window.  Figure 4.3 shows an example of what the Channel Mapping window 

will look like once all information required for scoring has been specified. 

 

It is very important that all aspects of the channel mapping are checked for each individual channel 

and for every individual study when sending for scoring.  If the channel mapping is wrong the 

study will not score.  If the Polarity is wrong, the quality of the scoring may be affected. 
 

 
Figure 4.3 

 

 

 Press Score. 

 

Upon pressing Score, the file will be uploaded to YST servers for remote autoscoring performed at YST.  

By using the Remote File Manager (described in Section 4.5), you will be able to check the status of your 

file and retrieve the scoring results when they are available. 

 

Reminder: Each EDF file should have a unique file name.  EDF files that have been 

scored should never be re-named. 
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4.4  Uploading to the YST Server 

 

Upon pressing Score (see Figure 4.3), the upload component attempts to automatically connect to the 

YST servers, using the login information specified as described in Section 2.2.  The progress of this 

process will be indicated by the window shown in Figure 4.4.  

 

 

Figure 4.4 

The file will be compressed during the upload to speed up the uploading process.  The progress will be 

displayed as shown in Figure 4.5 below.  

 

Figure 4.5 

 

4.5 Remote File Manager 

 

Remote File Manager is used to access the results of patient files scored by YST.  The Remote File 

Manager connects to the YST server using the supplied login information.  For the Remote File Manager 

to operate, login information must be specified via the Enter Login Information menu item, discussed 

next.  If the login information is invalid for any reason, the Remote File Manager will display an error 

message.  When connected, as seen below, a green check mark will be displayed beside connection status. 

 

Opening the Remote File Manager with correct login information will result in the window shown in 

Figure 4.6. 
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Figure 4.6 

The checkboxes located in the Status Filters pane list all potential file statuses and can be used to control 

which files are shown in the Remote Files pane.  Any file with a status that is not checked will not be 

shown.  All statuses are checked by default.  A user may un-check any status according to their preference 

for the display of file statuses.  For instance, if a user does not want to see the list of files that have 

already been downloaded, the “Downloaded” status may be un-checked. 

The File Information pane shows relevant information related to the status of the file.  This information 

consists of a combination of the following: the time of the upload, the time of scoring, the time of 

download, the upload percentage, or an error message.  What is displayed is dependent on the status of 

the file. 

The Remote Files pane lists all of the files that were sent for scoring.  The status of each file will be 

displayed, such as Uploading, Scoring, Available, Downloaded, New Scoring Available and Error. The 

additional status “Previously Downloaded” would be displayed if a second computer logs into the Viewer 

and reviews the same files with the Remote File Manager. Since it was not the original computer but 

same Login ID and Password, “Previously Downloaded” would appear as a status.  

Multiple files can be uploaded and sent for scoring.  The first will upload, and the next will be pending 

until the first has uploaded.  The files will upload and score in a consecutive manner.  See Figure 4.7 

below. 
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Figure 4.7 

Each row in the table represents a patient file uploaded to the YST servers.  Each patient file is assigned a 

specific status: 

 Uploading: the file is currently uploading to the YST server. 

 Pending: the file has been prepared for uploading, but is waiting for another upload to finish. 

 Scoring: the file is currently being scored. 

 Error: scoring the file has been attempted by YST, but resulted in an error.  Files with this status 

will be investigated, and you may contact YST to obtain further information. 

 Unavailable: the file has been uploaded, but has not been scored. 

 Available: the file has been uploaded and has been scored by YST, but the user has not 

downloaded the results files.  A “Download” button is available for the user to press, to download 

the results files. 

 Downloaded: the file has been uploaded, scored by YST, and the user has downloaded the results 

files. 

 New Scoring Available: the file has been downloaded previously; however, the results files 

present on the server are newer than the version that the user has downloaded.  A “Download” 

button is available for the user to press, to download the updated results files. 

 Previously Downloaded: the file has been uploaded, scored by YST, and the current user was 

not the original user that has downloaded the results file 
When there is an error during the scoring process, the file status will show as Error in the Remote Files 

pane and there will be information within the File Information pane.  An example is shown in Figure 4.8 

below. 
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Figure 4.8 

If there is an error in establishing a connection to the server, a notification will appear over top of the 

Remote Files pane, as shown in Figure 4.9. 

 

Figure 4.9 

There are three error messages that can appear here: 
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 Unable to connect to YST Servers.  This message indicates a problem identifying the YST 

Servers.  The most common solution to this error is to verify that the computer has Internet 

access.  This message is also shown during YST Server downtime. 

 Invalid Username and/or password.  This message indicates a problem with your login 

credentials.  Follow the steps described in Section 2.2. 

 Unable to set up connection.  This message indicates that the YST Servers are refusing the 

connection attempt.  If this message is shown, please contact YST Support for assistance (see 

Section 8 for contact information). 

 

Downloading from the YST Server 

 

If a new automated scoring results file is available, a small YST icon will appear on your task bar.  You 

will also see a Download button next to the File Name in your Remote File Manager.  Click on the 

Download button to download the scoring results file.  When the download is complete, you can close the 

Remote File Manager. 

 

The Remote File Manager can be used either with a file open, or with no file open.  If the automated 

scoring results file that corresponds to a currently opened file has been downloaded, the scoring results 

are automatically loaded.  The results file may require selection from the dropdown box when other 

scoring results files are present.   

 

If a results file has been downloaded for a file that is not currently open, the results are automatically 

retrieved when the file is opened. 

 

There is no need to specify target directories for the download, or try to seek out the results file 

on the computer file system. 

 

The scoring results will be displayed in the Scores Window within the Viewer. 
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4.6 The Scores Window 

 

The scoring results file is given the name [patient file name]_YSTEvents.ev and is set as read only.  This 

means that it cannot be modified without first using the copy functionality located in the Scores Window.  

The results file is automatically found, but may require selecting it from the dropdown box. 

 

Example: If the patient file is named patient_0030.edf, the output of the autoscoring will be 

placed in the same directory and named patient_0030_YSTEvents.ev 

 

 

 

The Scores Window is used to show the scoring results for the given file, as well as provide an interface 

for handling multiple scoring files, including deleting and renaming events.  This window is illustrated 

below in Figure 4.10. 

 

 

 

 
 

 
Figure 4.10 

 

The Main Window displays all scoring events and marker tags that are present in the file.  Double-

clicking on a line in the window will jump to the epoch containing the event, and select the event. 

 

Note: If a marker tag event is double-clicked, the display will jump to the epoch but will 

not select the event. 

 

Main Window 

Scoring File 

List 

Copy Selected 

Score File 

Import Body 

Position File 

Synchronize with 

Body Position 

Channel 

Filter Event 

List 
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The categories shown in the Main Window are as follows. 

 

Epoch displays the 30-second epoch that contains the start of the event. 

Event displays the event name. 

Start Time displays the event start time. 

Duration displays the event duration. 

Channel Name displays the name of the channel that the event is currently bound to (located on).  Marker 

tags are not bound to any specific channel. 

 

The Main Window can be sorted by any of the following categories: 

 Start Time/Epoch (same category) 

 Event Name 

 Event Duration 

 

The Scoring File List allows the selection of which existing scoring file to display.  Scoring files located 

in the same directory as the patient file are automatically detected by the application and placed in this 

list.  When a study is scored for the first time, the YSTevents.ev file will be shown.  After the study has 

been copied and edited, the last score file used will be displayed when opened next. The drop down menu 

allows the user to switch between study scores. 
 
The Copy Selected Score File button can be used to copy the current scoring file into a new file.  Copying 

a file in this manner preserves all settings; however, it does not preserve the read-only tag.  Copying may 

also be done by choosing to Save the current event file, and then entering a new name. 

 

The Import Body Position File button is used to import a file with position and lights data, which the user 

has created in the manner described in Section 4.2 (following item 4.b in that section). 

 

 

This option does not need to be used prior to executing automated scoring, because the autoscoring allows 

a body position file to be specified. 
 
The Synchronize with Body Position Channel button tells the software to read the body position out of an 

existing channel.  Pressing this button will remove any body position markers already placed.  For this 

feature to work, a body position channel must be defined in the Channel Mappings window (see Section 

4.2), and voltage ranges must be defined and enabled (see Section 3.8).  It should be noted that the 

autoscoring package automatically extracts information from the body position channel if both it and 

voltage ranges are defined.  This option does not need to be used prior to executing automated scoring. 

 

The Filter Event List button allows for specification of the type of event that should be displayed in the 

Main Window.  Clicking this button will display a menu that lists the different categories of events, as 

shown in Figure 4.11. 

 



  User Manual – MICHELE Sleep Scoring System 
    

  Revision: 23 
  Effective Date: 04-Nov-14 
  Document Number: YST-UDoc-USM-23 

To be used with Viewer version 1.02.043, 1.02.044 and 1.02.046 
 

 

83 

 
 

Figure 4.11 

 

Any item with a check is displayed in Main Window, and any item without a check is not displayed.  

Selecting an item will toggle its state.  The events included in each category are as follows: 

 

 Arousals 

o Arousals 

 Respiratory 

o All Apneas, Hypopneas and RERAs 

 PLMs 

o PLMs 

 Oxygen Events 

o Desaturations and Bad Oxygen Regions 

 Markers 

o Body Position, Lights On/Off, CPAP On, CPAP Levels, BiPAP Levels, Oxygen Levels 

 Sleep 

o All Sleep Stages 

 Snoring 

o All instances where snore signals have been detected 

 Cardiac Observations 

o All instances where Cardiac Observations have been detected 

 General Observations 

o Any other observations besides Cardiac 

 Custom 

o All Notes and Unspecified Events 
 

To delete an event from the scores window, left-click on the event to highlight it, and press “Delete” on 

the keyboard.  Multiple events can be deleted at one time by left-clicking an event and holding down the 

“Ctrl” key while left-clicking on additional events to be deleted.   
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 Note: Sleep or Body Position events cannot be deleted from the Scores Window.  

To rename an event from the scores window, right click the event.  A menu will appear with events that 

the selected event can be renamed to (Figure 4.12).  To rename multiple events at once, the user can left-

click an event, hold down the “Ctrl” key while left-clicking other events to be renamed.  The user would 

then right click one of the selected events and choose the new event name.  

 Note: This will only rename respiratory events. 

 

Figure 4.12 
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4.7 The Graph Window 

 
 

 

 
Figure 4.13 

 

 

 

The Graph Window consists of the main display for the application.  It contains the graphical 

representation of all channels, events, key markers, patient information and sleep staging, as shown above 

in Figure 4.13. 

 

The View Toggle allows switching between viewing the graphical representation of the current file and 

viewing the analysis notes.  The currently opened file name is displayed in the left-most (orange) tab of 

the Graph Window (file name not shown in Figure 4.13).  The analysis notes are discussed in Section 

5.10. 

 

The Mouse Cursor Indicator shows a line representation of where the mouse cursor is located on the 

screen. 

 

The Epoch Divider is a solid line that can be used to distinguish where the boundaries between 30-second 

epochs are located.  Epoch dividers are not shown if the compression is set to either 1000 seconds or the 

entire file. 

 

Graph Tray 
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View Toggle 
Sleep Display Channel Info 
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The Epoch Number is placed to the right of any epoch dividers, including the bottom left corner if the 

display is aligned to epoch boundaries.  This number indicates which epoch starts at a given boundary. 

 

The Channel Header Area displays the name and a value for different channels that are visible.  This is 

the value at the point in time where the mouse cursor is located. 

 

Selecting a channel is possible by clicking on the channel name in the channel header.  Multiple channels 

may be selected by holding down the “Ctrl” key and clicking on multiple names. 

 

 
Figure 4.14 

 

Figure 4.14 shows a selected channel.  Dotted lines outline it and two arrows appear beside the name.  

The dotted lines show the bounds of the channel, and no part of the channel will appear outside of these 

bounds.  The arrows beside the channel name are used for quick scaling of the channel.  Pressing the “up” 

arrow will enlarge the channel by halving the limits about the midpoint, while pressing the “down” arrow 

will shrink the channel by doubling the limits about the midpoint.  These limits are discussed in more 

detail in the Section 3.3 describing the Graph Channels property window. 

 

Example: If a channel is set to display values from 25 to –75, the midpoint is –25 with 

±50 on either side.  Pressing the “up” arrow changes the limits to –25 ±25.  Pressing the 

“down” arrow changes the limits to –25 ±100. 

 

The value appearing beside the channel label is the signal value at the cursor location. 
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5.0 Editing a File 

 

The results of automated scoring must be edited before the final report can be created.  The graph window 

will display “UNEDITED” in the background of any file that has not been edited (Figure 5.0)  This 

section describes the features of the Viewer that allow editing a file.   

 

Figure 5.0 

 

5.1 Copying a File for Edit 

 

Before a file can be edited, the results file provided by YST must be copied.  This is done by using the 

“Copy Selected Score File” button located in the Scores Window (see Section 4.6).  Refer to Figure 5.1 

below.  It is recommended to re-name the file by adding to the original file name the name of the person 

performing the editing, and the word “edit” behind it.  For instance, “[original file name] Kris edit.ev”. 
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Figure 5.1 

5.2 How to Edit a Study 

 

Once the score file has been copied it can be thoroughly edited.  Editing a file produces a log file that 

records all changes made to the file.  This file consists of entries that contain the following information: 

[Time of Day of edit]: [Action] [Epoch], changed from [original value] to [new value]. 

 

The file name for this file is identical to the name of the scoring file being edited, with the extension 

changed to .txt.  This file is located within the patient’s subfolder along with the EDF, .txt files and all 

else that will be generated. 

 

The following is a summary of the different editing activities that can be done: 

 

1. Events can be deleted by selecting an event and pressing the Delete key. 

2. Events can be added in one of two ways: 

a. By left clicking on an empty section of a channel, holding the mouse button down and 

moving the mouse.  This uses the Default Event property of the channel to determine 

event type (see Section 3.3 and the section on Creating and Event, below). 

b. By right clicking on an empty section of a channel.  Uses two properties of the channel to 

determine events: Default Event to determine the event type, and Default Duration to 

determine the event duration (see Section 3.3 and the section on Creating an Event, 

below). 

3. Events can be resized by left clicking on either vertical edge of the event, holding the mouse 

button down and moving the mouse. 

4. Events can be moved by left clicking on the event, holding the mouse button down, and moving 

the mouse. 

5. Events can be renamed in one of three ways: 

a. Selecting an event, and choosing a new event name from the list provided by the Event 

Name property. 

b. Selecting an event, and pressing one of the key bindings that are set as described below 

(see Figure 5.1and the text that corresponds to it). 

c. Right clicking an event, and selecting a new event name from the list provided. 

6. Event associations can be toggled by using the check boxes provided in the properties window 

when an event is selected (see Section 3). 

7. Sleep staging can be restaged by using one of the key bindings that are set as described below 

(see Figure 5.1 and the text that corresponds to it), if the following conditions are met: 

a. Epoch duration is set to 30 seconds; 

b. The epoch boundary aligns with the left most edge of the display. 

Additional information is provided to help with rescoring: this can be accessed via the 

View menu (see Section 5.7).Note: Events are automatically re-associated when they are 

moved, renamed, created, or deleted.  This can be overridden by setting the associations 

manually (Section 5.3 below).  Once an association has been toggled, it will never be 

changed automatically.  To re-enable automatic association for that event, the event will 

need to be deleted and a new event placed in its spot.   
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Note: Events are automatically deleted when the sleep stage they occurred in is changed 

to Awake.  

 

5.3 Creating an Event 

 

There are two modes of event creation: Standard Mode and Quick Mode. 

 

Quick Mode involves right clicking anywhere on a channel.  This will create an event of type Default 

Event and duration Default Duration with the start being located at the cursor.  The creation of default 

events was described in Section 3.3, as part of the description of the Graph Channel Properties window.  

Quick mode is disabled if Right Click Adds Event is not selected in the Configuration Menu. 

 

In Standard Mode, events are created by holding the left mouse button down anywhere on a channel and 

then dragging the mouse - while still holding down the left button - either forward or backwards.  Once 

the event is covering the desired area, releasing the mouse button will finalize the event.  The created 

event will be the default type specified in the Channel properties. 

 

Pressing one of the following keys while an event is selected will change the name of the event as 

follows: 

 O – Obstructive Apnea 

 M – Mixed Apnea 

 C – Central Apnea 

 H – Hypopnea 

 R – RERA 

 

Key Bindings can be customized through the “Set Key Bindings” option in the Configuration menu.  

Sleep staging key bindings can be customized as shown in Figure 5.2 below.  Event Scoring and Event 

Associations key bindings can also be customized through their respective sections in this menu. 

 

 

Figure 5.2 
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Pressing one of the function buttons displays Figure 5.3 below. Once this window is open, press a key and 

the binding for this function will be modified.  If a key is already bound to another function, it cannot be 

bound to a new function without first un-binding it. 

 

Figure 5.3 

Pressing one of the invalid keys (shown above in Figure 5.3) will remove the key binding.  Key bindings 

are stored in the Montage. 

 

Right Click Adds Event is a toggle that, when selected in the Configuration menu, will enable or disable 

the ability for right clicking on the graph window to automatically create a default event.  Once created, 

right clicking on an event allows for the event name to be changed. 

 

The Sleep Display indicates the sleep stage that was scored for the currently viewed 30-second epoch.  If 

the epoch length is longer than 30 seconds, or a time offset has been added to the window, the sleep 

stages of multiple epochs are displayed. 

 

To modify the sleep stage, one of six keys can be pressed: 

Pressing “0” sets the sleep stage to Awake (displayed as W). 

Pressing “1” sets the sleep stage to stage N1 (displayed as 1). 

Pressing “2” sets the sleep stage to stage N2 (displayed as 2). 

Pressing “3” sets the sleep stage to stage N3 (displayed as 3). 

Pressing “5” sets the sleep stage to REM (displayed as R). 

Pressing “6” sets the sleep stage to Movement (displayed as M). 

 

These are the default key bindings.  Keys can be re-assigned by using the interface illustrated above in 

Figure 5.2. 

 

Modifying the sleep stage can only be done when the epoch duration is set to 30 seconds and the window 

is aligned to the epoch boundary. 

 

Reassign Events relocates all events of a specific type (Respiratory, Arousal, Desaturation, or Leg 

Movement) to a specified channel.  Upon reassigning events from multiple channels onto a single 

channel, there is no way to restore events to their previous individual channels.  This operation does not 

distinguish between Left Leg events and Right Leg events. 
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Individual Event Properties 

 

 

 

 

 

(a)                                                                           (b) 
 

 

 

 

 

 

 

 

 

 

  (c)                                                                          (d) 

Figure 5.4 

 

Selecting an individual event is done by clicking on the event box in the Graph Window, or on the marker 

in the Graph Tray.  The individual event properties deal with all configurable parts of the event.  The 

figures above show four different states for the event properties window.  Figure 5.4a shows a 

Desaturation event, Figure 5.4b shows a Respiratory event, Figure 5.4c shows a Leg Movement and 

Figure 5.4d shows a Body Position (graph tray marker) event. 

 

Note: If an event cannot be associated with another event, the check boxes for “With 

Arousal” and “With Respiratory” will be disabled.  This can be seen in Figure 5.4 (a) 

and (d).  Figure 5.4 (b) and (c) both have potential associations with other events. 

 If a PLM event is associated with an arousal or a respiratory event, the 

appropriate checkbox should be checked. 
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 If a respiratory event is associated with an arousal or a desaturation, the 

appropriate checkbox should be checked. 

These data are used for compiling statistics for the final report.  The displayed event 

name is updated for ease of identification for these associations. 

 

The Start Time property determines when the event starts.  This can be changed by entering a new value 

in the text box, or by using the mouse to move the event around. 

 

The Duration property determines the length of the event.  This can be changed by entering a new value 

in the text box, or by using the mouse to drag the edge of the event around. 

 

If the selected event is a Graph Tray marker event, the only modifiable property is the Start Time. 

 

Score File Manager (Figure 5.5) displays a dialog box that allows managing of the score files found for 

the currently opened EDF file, allowing you to delete score files as well as choose which score file to 

display.  Score files deleted by this method cannot be recovered. 
 

 

Figure 5.5 
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5.4 The Hypnogram 

 

The hypnogram (shown in Figure 5.6 below) is equivalent to a leaner form of the Graph Window. 

 

 
 

 

 

Figure 5.6 

 

The hypnogram contains a Time Marker that, when dragged by the mouse, changes the display of the 

Graph Window to the new location of the marker.  This functions both ways, and changing the display in 

the Graph Window will automatically move the marker. 

 

The hypnogram supports adding channels (in the same manner as the Graph Window), and the ability to 

evenly space channels. 

 

The Channel Display displays the visible channels for the specified time window.  It also displays all 

events at the appropriate start time with the appropriate duration and name of the event.  The event name 

is displayed on the physical event item.  The Channel Display allows the creation of events.  

 

Events can be selected in the same way as a channel, by simply clicking on the event.  Multiple events 

can be selected by holding down the “Ctrl” key while clicking on events.  A selected event will have its 

background color inverted. 

 

Events can be modified through the interface.  They can be dragged horizontally with the mouse, 

modifying the start time but keeping the duration intact.  As well, either the left or right boundary of the 

event can be dragged.   

 Dragging the right boundary will extend the event, preserving the start time but increasing the 

duration.   

 Dragging the left boundary will also extend the event, moving the start time back while 

increasing the duration and preserving the end point. 

 Either boundary can be dragged over the other boundary.  This will flip the event, turning the end 

point into the start point and vice versa. 

 

Events can be removed by selecting them and pressing the Delete key on the keyboard. 
 

Time Marker 
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5.5 The Graph Tray 

 

The Graph Tray, shown in Figure 5.7 below, composed of two rows, displays additional information 

about the state of the patient and shows global marker events. 
 

 
Figure 5.7 

 

In the lower row to the left, the Graph Tray displays the patient name, the start time of the file and the end 

time of the file. 

 

In the lower row to the far right, the Graph Tray displays the current body position as well as the current 

status of CPAP (either Off, On, or On with additional information, which will subsequently be elaborated 

on). 

 

In the top row, the Graph Tray displays key global events associated with the patient file.  These include 

body position changes, lights on/off, CPAP on time, CPAP level changes, BiPAP level changes, oxygen 

level changes, and custom notes. 

 

To add one of these global events, a right click on the top row of the Graph Tray brings up a selection 

menu that allows a marker to be specified as shown in Figure 5.8 below. 

 

 
Figure 5.8 

 

When one of these markers has been selected from the menu, an icon with the name of the marker is 

placed on the Graph Tray at the location of the mouse.  This icon can be selected by clicking on it, and 

moved by holding down and dragging the mouse, or deleted by pressing the delete key.   

 

Adding a CPAP Level, BiPAP Level or Oxygen Level event brings up a dialog box that requests 

parameters. 

 CPAP Level requires a value for the new level 

 BiPAP Level requires three values: Inspiratory Level, Expiratory Level and Backup Level 

 Oxygen Level requires a value for the new level 

Bottom Row 
Top Row 
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These parameters can be edited at any time by right clicking on the event marker icon. 

 

Adding a note will provide an option to enter some text.  These notes should be used only for short notes 

or to represent custom markers.  Any long or in-depth notes should be added to the analysis notes.  Notes 

cannot be edited once placed; however, an unlimited amount may be added and deleted.  Notes added via 

the notes marker are printed with the event list rather than the analysis notes. 

 

Figure 5.9 below shows an example of a Left Body Position marker next to a CPAP level 30 marker.  If 

any markers overlap each other, the markers will turn red to indicate that there are hidden events, shown 

in Figure 5.10 

 

    
 

Figure 5.9   Figure 5.10 

 

Several restrictions apply to different types of markers. 

 

 The Lights On and Lights Off markers automatically align to the nearest 30-second epoch 

boundary. 

o Only one of each of these markers can exist at a time.  For example, placing a second 

Lights Off event will remove the first Lights Off event. 

 Body Position markers automatically adjust their length based on surrounding body positions. 

o The last Body Position marker in the file will stretch to the end. 

o Placing two or more consecutive markers of the same Body Position will keep only the 

earliest marker. 

 Only one CPAP On flag may be present in the file.  Placing a second one will delete the first. 

 

Adding a CPAP On flag turns the study into a split study.  This causes the report to be split into two 

sections (pre CPAP and post CPAP).  For information on Report Generation refer to Section 6.  

 

5.6 EKG Artifact Removal 

 

EKG Artifact Removal is used to remove R-wave artifacts from the EKG that are corrupting other 

electrodes.  Selecting this menu option from the configuration menu will display the dialog box shown in 

Figure 5.11. 
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Figure 5.11 

 

This dialog has four key components, all of which must be used to remove r-wave artifacts. 

 The list of all channels, present on the left 

 The list of channels for which the R-wave should be removed, present on the right 

 A drop down selection box for the EKG Channel 

 A checkbox used to enable the R-wave removal algorithm 

 

For the R-wave artifact to be removed from a channel, it must be moved from the left list into the right 

list.  This is done by selecting the channel name and either double clicking or pressing the right arrow (>) 

button.  A similar approach will move a channel back to the left list (either double click or select a 

channel and press the left arrow (<) button). 

 

The EKG channel is selected using the provided drop down box.  The same channel entered in the 

channel mapping for EKG must be the EKG channel entered here.  Finally, the “Enable R-wave Artifact 

Removal” check box must be checked. 

 

Pressing Save will save your settings only and close the window.  The first time you press Save with the 

enable box checked, the window shown in Figure 5.12 will be displayed for a period of time. 
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Figure 5.12 

 

This window closes automatically when the required calculations are finished. 

 

Note: The R-wave removal module is automatically disabled whenever a file is opened and must 

be re-enabled as required. 

 

Another way to remove EKG artifact from selected channels would be to reference A1 and A2 

(or M1 and M2) together (refer to Section 3.5 for guidance on this procedure).  In other words, 

reference C4-A1/A2, as opposed to only referencing C4-A1, thereby averaging the two reference 

electrodes; this often removes the EKG artifact. 
 

5.7 The View Menu 

 

The View Menu is used to access different features related to how the information is displayed on the 

screen. 

 

Default Layout re-sizes the different windows (Graph Window, Properties Window, Scores Window and 

Hypnogram) to a default size and position on the screen.  This should be used to restore windows if one is 

accidentally moved off-screen or closed. 

 

Scale Channels scales the selected channels to fit their height entirely in the space assigned to the specific 

channels. 

 

Evenly Space Channels resizes the height and repositions each channel so that all visible channels occupy 

the same amount of space without overlap. 

 

Refresh Hypnogram updates the hypnogram channel display.  This redraws all channels, reflecting 

updates to data such as the sleep staging, body position, and location of events. 

 

Align to Epoch Boundary shifts the start of the currently displayed window to re-align itself with a 

multiple of the epoch length. 
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Show Patient Name, if chosen, will show the patient’s name at the bottom of event window.  The patient’s 

name is stored within the EDF file which is not shared with YST.  Only the signals are sent to YST for 

scoring, and no patient information is transferred.  
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5.8 Additional Information 

 

Show Additional Information opens a window that provides additional information to help with scoring, 

as shown in Figure 5.13. 

 

 

 
Figure 5.13 

 

This data window shows four categories of information about the current display. 

 Breath % High shows the current breath, as a percentage of the nearby reference breath, as well 

as the respiratory channel that provided the measurement (the data source). 

o Data Sources are as follows: 

 NC – Nasal Cannula 

 CPAP – CPAP Flow 

 Therm – Thermistor 

 Sum – Represents Respitrace bands when Inductive bands are used 

 Flow Limitation indicates if the current inspiration is showing any indication of flow limitation.  

Flow limitation applies only when the data source is CPAP or NC. 

 Desaturation Percent indicates if there is an oxygen desaturation in the vicinity of the cursor, and 

if yes, what percentage the desaturation is.  Only desaturations of 2% or more are reported, those 

less than 2% being insignificant. 

 Duty Cycle - The Duty Cycle is the time of inspiration (Ti) divided by the time of the entire 

breath (Ttot). 

 

The final value is the Delta Wave Duration value.  This is provided for both EEG1 and EEG2.  Delta 

Wave durations are intended to assist scoring and are therefore only shown when the epoch duration is set 

to 30 seconds, and the view is aligned to the epoch boundary (the same conditions that allow sleep 

staging). 
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The Breath % High, Flow Limitation, Desaturation Percent, and Delta Wave Duration can only be viewed 

if the autoscoring has already been completed for the opened file, and the generated data file (extension 

.rdat) is kept in the same directory as the opened file.  The reported values for all fields but Delta Wave 

Duration change based on the location of the mouse cursor on the Graph Window. 

 

5.9 The Toolbar 

 

The majority of the functionality in the toolbar is also accessible through the menus described earlier. 

Figure 5.14 below shows the Toolbar with definitions for the numbered items following it. 

 

 
 1  2   3  4    5    6 7 8  9      10                             11      13           14 12    15                 16 

Figure 5.14 

 

The following commands work exactly the same as the menu items described earlier: 

1. Open Patient File 

2. Save (prompts to save all three of the Montage, Score List and Analysis Notes, assuming there 

are unsaved changes) 

3. Generate Report 

4. Print 

5. Import Notes From File 

6. Scale Channels 

7. Refresh Hypnogram 

8. Evenly Space Channels 

9. Align to Epoch Boundary 

  

The following features are unique to the toolbar: 

10. Set Epoch Duration 

11. View Previous Epoch 

12. View Next Epoch 

13. Time of Position in File 

14. Current 30-second Epoch Number 

15. Animation Controller 

16. Montage Selector 

 

The Set Epoch Duration buttons consist of a number of durations which, when clicked, set the currently 

displayed window length to that amount of seconds.  The exception to this is the ALL button, which 

displays the entire file. 

 

Note: Processing can be quite slow when ALL is selected, and it is recommended that 

filtering and referencing are disabled when using this display mode. 

 

View Previous Epoch moves the current display back by the Epoch Duration.  This button does not adhere 

to epoch boundaries if the view has been shifted off the epoch boundary.  This functionality can be 

accomplished by pressing the Left arrow key.  Pressing the minus (-) key either on the numpad or the 

main keyboard will move the current display half an epoch backwards in time. 
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View Next Epoch moves the current display forward by the Epoch Duration.  This button does not adhere 

to epoch boundaries if the view has been shifted off the epoch boundary.  This functionality can be 

accomplished by pressing the Right arrow key.  Pressing the plus (+) key either on the numpad or the 

main keyboard will move the current display half an epoch forwards in time. 

 

The Time of Position in File controller is used both for informational purposes, showing the current time 

of the displayed window, as well as for control purposes.  

The time displayed in the controller is in HH:MM:SS AM/PM.  Any of the first three fields are selectable, 

which is indicated by a highlighting effect.  Entering a new value can modify a selected field, or it can be 

incremented/decremented through the up and down arrows.  This has the potential to remove the 

alignment with the epoch boundary, preventing the scoring of sleep.  Using Align to Epoch Boundary will 

reinstate this alignment and allow scoring to resume.  Scrolling the mouse wheel up will advance the 

graph window by the number of seconds currently displayed in the graph, while scrolling the mouse 

wheel down will move the display back by the number of seconds currently displayed in the graph.  Ex.: 

If “Display 30 Seconds” is selected as the currently displayed window length, scrolling the mouse wheel 

forward will advance the display by 30 seconds, while moving the mouse wheel down will move the 

display back by 30 seconds.  Pressing the Left and Right arrow keys on the user’s keyboard has the same 

effect as scrolling the mouse up (right arrow key) and down (left arrow key).   

 

The Current 30-second Epoch Number displays the current 30-second epoch that is shown earliest in the 

displayed window.  This number can be modified, and doing so will shift the start of the displayed 

window to the beginning of the 30-second epoch number entered. 

 

The Animation Controller allows for continuous scrolling of epochs across the screen at a fixed time 

interval, which is set using the drop down box.  The time intervals are in increments of 0.25 seconds, 

ranging from 0.25 to 3.00 seconds. 

 

Note: When animating large compressions with a fast time interval, this feature may 

behave irregularly.  If irregular behaviour is observed:  

 Stop the animation. 

 Select “Align to Epoch Boundary” from the menu or toolbar. 

 Select a slower time interval.  

The first two steps are vital to guaranteeing proper functionality of any further 

operations.  The third step is required only if animation is to be attempted again. 

 

To use the Animation Controller, first select a time from the drop down box, then press either Play   to 

scroll forward, or Rewind  to scroll backwards. 

 

The Montage Selector is used to change the current Montage.  Montages are discussed in Section 3.9. 

 

Selecting the Save Scoring File option that is listed under the Save option of the File Menu displays the 

window shown in Figure 5.15. 

 

 Note: If the software crashes, an option will appear to save your .edited scored file.  Please note 

that this may corrupt the .ev file if an event was what caused the crash 
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Figure 5.15 

 

5.10 Analysis Notes 

 

The Analysis Notes tab should be used to enter additional information about a patient file that cannot be 

added through the scoring interface.  Only one set of notes is allowed for each patient file, and they are 

stored in a specific file (.notes extension) that should not be renamed or modified outside of the 

application.  The notes, if present, are appended at the end of the generated report.  Editing the analysis 

notes is done using the provided interface, which functions as a text editor. 

 

Selecting Save Analysis Notes will save the analysis notes.  Since there is only one set of analysis notes 

per file, no secondary prompt is required. 

5.11 Print Example 

Print allows printing of any of four windows.  These are the Graph Window, the Hypnogram, the 

Analysis Notes, and the Event List.  All of these windows are printed as they are shown on the screen. 

 

Selecting Print brings up a dialog that allows the selection of which window to print shown below in 

Figure 5.16. 
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Figure 5.16 

 

Note: Printing the Event List applies the specified event filters.  Event filters are 

discussed further in Section 4.6. 

 

6.0 Generating the Report 

 

Generate Report allows for the user to generate a customized  report for the opened patient file and 

scoring file using the Report Editor.  Please refer to Appendix A – Report Editing for information on 

using the Report Editor to create customized reports from scored patient files. 

 

7.0 The Help Menu 

 

 
 

 

Figure 7.0 

 

In the Help menu, shown in Figure 7.0, About displays a dialog box giving information about the software 

version as well as copyright information. 
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View User Manual displays a PDF formatted current User Manual associated with the current Viewer 

Release as shown below in Figure 7.1. 

 

 
 

Figure 7.1 

 

View Release Notes displays a Text box indicating release notes pertaining to the current Viewer in use as 

shown below in Figure 7.2. 

 

 
 

Figure 7.2 
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End users can review the release notes or the User Manual at any time by selecting these menu items 

within the Help Menu.  These documents can be printed if desired. 

 

Regulatory Information displays the Label for the Michele Sleep Scoring software, as well as Instructions 

for Use and Younes Sleep Technologies contact information. 

 

8.0 Troubleshooting 

 

8.1Error Message 

 

In the event of a failure of any part of the Viewer application, an error message will appear shown below 

in Figure 8.0. 

 

 
 

Figure 8.0 

 

Pressing OK will signal the Viewer to automatically send an email to YST Support containing critical 

information about the error encountered during its use at that particular point.  Users do not have to do 

anything at this point. 

 

Pressing OK will cause the software to terminate which is a normal event. 

 

8.2 Notifying YST of Perceived Software Failure 

 

In the event that an error in autoscoring has been incurred or perceived, it is recommended that the user 

first consider and verify the following: 

a) Correspondence between the list of channels specified prior to data processing, and the order 

of channels in the data file (see Section 3.9 above on channel mapping); 

b) Specification of times of lights on and lights off (Section 4.2); 

c)  Use of data collection requirements per Section 1.2 above; 

d)  File type; 

e)  Report specifications (see Section 6 above). 

 

If the user is unable to resolve the error, it is recommended that the file causing the failure be sent to YST 

with a full description of the events preceding identification of the error, so that it can be appropriately 

investigated (and potentially used to improve the reliability of the software).  If the results of autoscoring 

have been manually edited, YST may also request that the user send the results of manual editing.  
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Contact Information: Please contact YST for enquiries, technical assistance, or for reporting complaints.  

 

Please phone toll-free, 1-888-942-6774, or e-mail support@michelesleepscoring.com.   

 

Mailing address: 1 Morley Avenue, Princess Elizabeth Building 

Winnipeg, Manitoba, Canada 

R3L 2P4 

9.0 Optional Server Setup 

 

9.1 Requirements 

 

 Microsoft Windows Server 2003 or later (64 bit). 

 

 6GB of RAM per instance of the viewer. 

 

9.2 Installation 

 

Complete the installation as described in Section 2.0, making sure to install the Viewer for “Everyone” 

and not “Just for me” (see Figure 2.10). 

 

9.3 Configuration 

 

Create the 'master' download directory. This is the location that all Viewers, once configured using the 

steps below, will download results files to. In this example, C:\downloads will be used. 

 

For each user on the server do the following: 

 

 Login to the server using the user’s credentials.  Run the Viewer once. Close the Viewer.  This is 

to create the Application Data directory, and the default download directory (which is empty at 

this point). 

 

 Remove the downloads directory located at C:\Users\USERNAME\AppData\Roaming\Yst 

Limited\Yst Viewer\downloads. Note that showing hidden folders will be required to be on to see 

AppData. 

 

 Open a command prompt and link the master downloads directory in place of the user specific 

one.  This can be done with the following command (substituting USERNAME as before): 

“mklink /D C:\Users\USERNAME\AppData\Roaming\Yst Limited\Yst Viewer\downloads 

C:\downloads”. 

 

9.4 Miscellaneous  

 

There is a known issue wherein if two instances of the Viewer download the same file and they both 

finish within 1 second of each other, one will crash.  This is not expected to occur in daily use, and is 

being addressed in later revisions. 
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10.0 Attachments 

 

10.1 A sample report generated by the MICHELE Sleep Scoring System is attached (nine pages, 

including the cover page/label). 

 



Michele Sleep Scoring System Report Label

Document Number: YST-Label-001-12
Revision: 12

Effective Date: 04-Nov-14

This Report Was Generated by:
MICHELE Sleep Scoring System

Name and address of the manufacturer:
Younes Sleep Technologies (YST)

 1 Morley Avenue, Princess Elizabeth Building
 Winnipeg, Manitoba R3L 2P4
 Canada
             Tel: 1-888-942-6774

Name and address of the EU Authorized Representative: Name and address of the Australian Sponsor:
Advena Ltd.
Pure Offices
Plato Close
Warwick, CV34 6WE
UK

Emergo Australia
Level 20
Tower II, Darling Park
201 Sussex Street
Sydney, NSW 2000
Australia

EC REP

Intended Use:
The MICHELE Sleep Scoring System is a computer program (software) intended for use as an aid
for the diagnosis of sleep and respiratory related sleep disorders.
The MICHELE Sleep Scoring System is intended to be used for analysis (automatic scoring and
manual rescoring), display, redisplay (retrieve), summarizing, reports generation and networking of
digital data collected by monitoring devices typically used to evaluate sleep and respiratory related
sleep disorders.
The device is to be used under the supervision of a physician.  Use is restricted to files obtained from
adult patients.

Warnings and Cautions:
The MICHELE Sleep Scoring System does not analyze data that are different from those analyzed
by human scorers.
The attached report contains numerical and graphical data typical of those generated following
manual scoring of polysomnograms.  It does not contain any interpretation, diagnosis or
recommendations for treatment. These decisions are to be made by the treating physician.
The scoring provided by the MICHELE Sleep Scoring System must be reviewed, edited as necessary
and approved before the report is generated.
Special attention should be paid to confirm the first epoch of Rem sleep and of non-Rem sleep since,
occasionally, brief periods of either kind can be missed or mistakenly scored resulting in large errors
in sleep latency or Rem latency.
Arousals may be underreported in cases where arousal frequency is very high.
Any modification to any component of the MICHELE Sleep Scoring System may result in erroneous
results or failure of the software to operate.
Caution: US Federal law restricts this device to sale by or on the order of a physician.

Identifier of the device:      CE mark:
 Viewer Version: 1.02.046
 Release Date:  15-Dec-14

Autoscoring Version: 1.00.107 
 Release Date:  09-Nov-12 0086



 SLEEP ANALYSIS REPORT
Patient Name:

2

Recording Information

Study

 Study Date:

 Study Type:

 ID #:

Patient

 Patient Name:

 Gender:

 Date of Birth:

 Social Security #:

 Healthcare #:

 Neck Circumference:

 Weight:

 Height:

 BMI: N/A

 Epworth Scale:

Medications:

Medical Personnel

 Referring Doctor:

 Interpreting Doctor:

 Collection Technician:

 Scoring Technician:



 SLEEP ANALYSIS REPORT
Patient Name:

3

PRE CPAP

SLEEP VARIABLES

Lights Off 21:28:41 Time at CPAP On 23:57:36
Total Sleep Time (TST) 95.0 Total Recording Time 148.9
Sleep Efficiency (%) 63.8 Wake After Sleep Onset (WASO) 15.9
Sleep Latency 38.0 Rem Latency N/A
Sleep Period Time 110.9 Rem Latency Minus Wake Time N/A
Stage1 Cycles 34 Total Awakening 18
Total Stage Shifts 88

TIME IN EACH STAGE

Sleep Stage Time (min) %TST Latency
Awake 53.9 56.8

N1 35.0 36.8 38.0
N2 60.0 63.2 42.0
N3 0.0 0.0 N/A

Rem 0.0 0.0 N/A
Total Non-Rem 95.0 100.0 38.0

AROUSALS

Total Rem Non-Rem
Number Index Number Index Number Index

Respiratory 110 69.5 N/A N/A 110 69.5
With PLMs 0 0.0 N/A N/A 0 0.0
Spontaneous 14 8.8 N/A N/A 14 8.8
Total Arousals 124 78.3 N/A N/A 124 78.3

LEG MOVEMENTS

Total Rem Non-Rem N1 N2 N3
Number Index Number Index Number Index Number Index Number Index Number Index

PLMs 4 2.5 N/A N/A 4 2.5 3 5.1 1 1.0 N/A N/A
  With Arousal 0 0.0 N/A N/A 0 0.0 0 0.0 0 0.0 N/A N/A
  Without Arousal 4 2.5 N/A N/A 4 2.5 3 5.1 1 1.0 N/A N/A
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RESPIRATORY EVENTS BY SLEEP STAGES

Total Rem Non-Rem Duration
Number Index Number Index Number Index Average Maximum

Central Apnea 58 36.6 N/A N/A 58 36.6 20.1 35.6
Obstructive Apnea 78 49.3 N/A N/A 78 49.3 19.5 32.4
Mixed Apnea 23 14.5 N/A N/A 23 14.5 23.0 39.1
Obstructive Hypopnea * 32 20.2 N/A N/A 32 20.2 20.6 36.8
Undefined Hypopnea * 3 1.9 N/A N/A 3 1.9 19.8 26.2
RERA 0 0.0 N/A N/A 0 0.0 0.0 0.0
All Apneas 159 100.4 N/A N/A 159 100.4 20.2 39.1
Apneas + Hypopneas 194 122.5 N/A N/A 194 122.5 20.3 39.1
Apneas + Hypopneas + RERAs 194 122.5 N/A N/A 194 122.5 20.3 39.1

*Scored by criteria A

RESPIRATORY EVENTS BY BODY POSITION

Total Supine Right Left Prone Upright
Number Index Number Index Number Index Number Index Number Index Number Index

Central Apnea 58 36.6 58 36.6 N/A N/A N/A N/A N/A N/A N/A N/A
Obstructive Apnea 78 49.3 78 49.3 N/A N/A N/A N/A N/A N/A N/A N/A
Mixed Apnea 23 14.5 23 14.5 N/A N/A N/A N/A N/A N/A N/A N/A
Obstructive Hypopnea 32 20.2 32 20.2 N/A N/A N/A N/A N/A N/A N/A N/A
Undefined Hypopnea 3 1.9 3 1.9 N/A N/A N/A N/A N/A N/A N/A N/A
RERA 0 0.0 0 0.0 N/A N/A N/A N/A N/A N/A N/A N/A
ALL Apneas 159 100.4 159 100.4 N/A N/A N/A N/A N/A N/A N/A N/A
Apneas + Hypopneas 194 122.5 194 122.5 N/A N/A N/A N/A N/A N/A N/A N/A
Apneas + Hypopneas +
RERAs

194 122.5 194 122.5 N/A N/A N/A N/A N/A N/A N/A N/A

O2 SATURATION STATISTICS

Overall Rem N-Rem Supine ** Lateral ** Prone **
Maximum 98.0 N/A 98.0 98.0 N/A N/A
Average 92.0 N/A 90.9 90.9 N/A N/A
Minimum 78.0 N/A 79.0 79.0 N/A N/A
# desaturations > 2% (Index) ** 196(79.0) N/A (N/A) 196 (123.8) 196 (123.8) N/A (N/A) N/A (N/A)
# desaturations > 3% (Index) ** 193(77.8) N/A (N/A) 193 (121.9) 193 (121.9) N/A (N/A) N/A (N/A)
# desaturations > 4% (Index) ** 193(77.8) N/A (N/A) 193 (121.9) 193 (121.9) N/A (N/A) N/A (N/A)
% Sleep Time > 90% 66.6 N/A 56.3 56.3 N/A N/A
% Sleep Time 80-90% 28.0 N/A 40.8 40.8 N/A N/A
% Sleep Time 70-80% 0.3 N/A 0.3 0.3 N/A N/A
% Sleep Time 60-70% 0.0 N/A 0.0 0.0 N/A N/A
% Sleep Time 50-60% 0.0 N/A 0.0 0.0 N/A N/A
% Sleep Time <50% 0.0 N/A 0.0 0.0 N/A N/A
% Sleep Time with Bad Signal 5.1 N/A 2.6 2.6 N/A N/A

** Only time in sleep considered.
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POST CPAP

SLEEP VARIABLES

Time at CPAP On 23:57:36 Time at Lights On 03:57:41
Total Sleep Time (TST) 217.5 Total Recording Time 240.1
Sleep Efficiency (%) 90.6 Wake After Sleep Onset (WASO) 21.5
Sleep Latency 0.0 Rem Latency 24.0
Sleep Period Time 239.0 Rem Latency Minus Wake Time 7.5
Stage1 Cycles 10 Total Awakening 7
Total Stage Shifts 32

TIME IN EACH STAGE

Sleep Stage Time (min) %TST Latency
Awake 22.6 10.4

N1 33.0 15.2 18.6
N2 135.0 62.1 1.1
N3 0.0 0.0 N/A

Rem 49.5 22.8 24.0
Total Non-Rem 168.0 77.2 1.1

AROUSALS

Total Rem Non-Rem
Number Index Number Index Number Index

Respiratory 3 0.8 0 0.0 3 1.1
With PLMs 0 0.0 0 0.0 0 0.0
Spontaneous 20 5.5 3 3.6 17 6.1
Total Arousals 23 6.3 3 3.6 20 7.1

LEG MOVEMENTS

Total Rem Non-Rem N1 N2 N3
Number Index Number Index Number Index Number Index Number Index Number Index

PLMs 10 2.8 0 0.0 10 3.6 2 3.6 8 3.6 N/A N/A
  With Arousal 0 0.0 0 0.0 0 0.0 0 0.0 0 0.0 N/A N/A
  Without Arousal 10 2.8 0 0.0 10 3.6 2 3.6 8 3.6 N/A N/A
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RESPIRATORY EVENTS BY SLEEP STAGES

Total Rem Non-Rem Duration
Number Index Number Index Number Index Average Maximum

Central Apnea 1 0.3 0 0.0 1 0.4 13.9 13.9
Obstructive Apnea 0 0.0 0 0.0 0 0.0 0.0 0.0
Mixed Apnea 0 0.0 0 0.0 0 0.0 0.0 0.0
Obstructive Hypopnea * 2 0.6 0 0.0 2 0.7 39.8 68.0
Undefined Hypopnea * 2 0.6 0 0.0 2 0.7 14.7 16.2
RERA 0 0.0 0 0.0 0 0.0 0.0 0.0
All Apneas 5 1.4 0 0.0 5 1.8 15.6 17.6
Apneas + Hypopneas 9 2.5 0 0.0 9 3.2 20.8 68.0
Apneas + Hypopneas + RERAs 9 2.5 0 0.0 9 3.2 20.8 68.0

*Scored by criteria A

RESPIRATORY EVENTS BY BODY POSITION

Total Supine Right Left Prone Upright
Number Index Number Index Number Index Number Index Number Index Number Index

Central Apnea 1 0.3 1 0.3 N/A N/A N/A N/A N/A N/A N/A N/A
Obstructive Apnea 0 0.0 0 0.0 N/A N/A N/A N/A N/A N/A N/A N/A
Mixed Apnea 0 0.0 0 0.0 N/A N/A N/A N/A N/A N/A N/A N/A
Obstructive Hypopnea 2 0.6 2 0.6 N/A N/A N/A N/A N/A N/A N/A N/A
Undefined Hypopnea 2 0.6 2 0.6 N/A N/A N/A N/A N/A N/A N/A N/A
RERA 0 0.0 0 0.0 N/A N/A N/A N/A N/A N/A N/A N/A
ALL Apneas 5 1.4 5 1.4 N/A N/A N/A N/A N/A N/A N/A N/A
Apneas + Hypopneas 9 2.5 9 2.5 N/A N/A N/A N/A N/A N/A N/A N/A
Apneas + Hypopneas +
RERAs

9 2.5 9 2.5 N/A N/A N/A N/A N/A N/A N/A N/A

O2 SATURATION STATISTICS

Overall Rem N-Rem Supine ** Lateral ** Prone **
Maximum 100.0 99.0 99.0 99.0 N/A N/A
Average 96.9 96.5 97.1 96.9 N/A N/A
Minimum 88.0 94.0 88.0 88.0 N/A N/A
# desaturations > 2% (Index) ** 24 (6.0) 3 (3.6) 21 (7.5) 24 (6.6) N/A (N/A) N/A (N/A)
# desaturations > 3% (Index) ** 13 (3.2) 0 (0.0) 13 (4.6) 13 (3.6) N/A (N/A) N/A (N/A)
# desaturations > 4% (Index) ** 11 (2.7) 0 (0.0) 11 (3.9) 11 (3.0) N/A (N/A) N/A (N/A)
% Sleep Time > 90% 97.6 100.0 99.1 99.3 N/A N/A
% Sleep Time 80-90% 0.2 0.0 0.3 0.2 N/A N/A
% Sleep Time 70-80% 0.0 0.0 0.0 0.0 N/A N/A
% Sleep Time 60-70% 0.0 0.0 0.0 0.0 N/A N/A
% Sleep Time 50-60% 0.0 0.0 0.0 0.0 N/A N/A
% Sleep Time <50% 0.0 0.0 0.0 0.0 N/A N/A
% Sleep Time with Bad Signal 2.2 0.0 0.6 0.5 N/A N/A

** Only time in sleep considered.
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Graphs

DURATION RESPIRATORY OXIMETRY
Level Total

(min.)
REM
(min.)

NREM
(min.)

Cen.
Apnea

Obs.
Apnea

Mxd.
Apnea

Undef.
Apnea

Hypop
nea

A+H
Total

AHI Max
SpO2

Min
SpO2

Avg
SpO2

7 14.8 0.0 0.5 0 0 0 1 0 1 119.8 98.0 89.0 96.8
9 38.3 31.8 6.0 0 0 0 3 3 6 9.5 98.0 88.0 95.4
10 182.7 17.7 160.5 1 0 0 0 1 2 0.7 100.0 90.0 97.3
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Introduction 

 

To suit the individual needs of each user, the Viewer has the ability to create and use report templates to 

display the results of autoscoring by MICHELE for both Level 1 and Level 3 studies.  To facilitate the 

development and deployment of report templates, the Viewer software package includes a Report Editor.  

The Report Editor presents users with a free-style word processing interface which allows for the 

construction of customized reports.  Default templates are included, and can be used as-is, or as a starting 

point and modified to suit each user’s requirements.  Users are also able to upload a report template 

currently being used in their lab, and configure it to display the pertinent information using Unique 

Identifier Keys.  There is no limit to the number of customized reports users are able to create; users may 

wish to create a report template for each type of study their lab performs (Split-night, CPAP only, no 

CPAP, etc.).   

1.0 Features of the Report Editor 

1.1 Opening the Report Editor 

To open the Report Editor, from the Viewer Main Menu, select “Report Editor” from the File menu.  The 

Report Editor will open within the Viewer and present itself as a blank document.  The Report Editor 

interface looks and functions similarly to most word processing software systems, such as Microsoft® 

Word, OpenOffice, or LibreOffice.  Please note that while the Report Editor is open all other features 

or applications in the Viewer will be inaccessible. 

1.2 Title Bar 

On the top of the Report Editor window is a long bar called the Title Bar.  On the left side of the title bar 

there is an icon that represents the application.  To use the system menu on the application icon, click the 

small icon.  A menu will appear, and from this menu you are able to Maximize, Minimize, or Restore the 

window to its original size; Move the window; or Close the window.  The Report Editor can also be 

maximized or minimized by double clicking the blank area inside the Title Bar (Figure A-1). 

 

Figure A-1 

 

Title Bar 
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1.3 Menu Bar 

Directly under the Title Bar is the Menu Bar, which is composed of several menus (File, Edit, View, 

Insert, Format, and Table) (Figure A-2).  Each menu on the Menu Bar allows the user to perform many 

operations pertinent to word processing.  Most users may be familiar with these menus from prior 

experience using word processing software; however, they are detailed in sections 1.4 – 1.9 below.  If a 

particular menu item has a keyboard shortcut, this is indicated beside that item in the menu (e.g. to create 

a new report, the user can press Ctrl+N on their keyboard instead of accessing this function through the 

File menu).  Additionally, certain functions have picture icons beside them in their respective menus.  

This is to indicate which functions have shortcuts on the Toolbar menu, further explained in section 1.10 

below.  

1.4 File Menu 

The File menu (Figure A-2) allows users to create a new report, open an existing report, save the current 

report, print the current report, view recently opened reports, or exit the Report Editor.   

 

Figure A-2 

1.5 Edit Menu 

The Edit menu (Figure A-3) allows users to undo previous actions; redo actions that have just been 

undone; cut, copy, paste, or delete text and images; select all text or images; find a particular word; and 

find and replace a word with a different word.  The Hyperlink function allows users to edit a URL link 

that they’ve previously inserted via the Insert menu described in section 1.7 below. 

 

 

Menu Bar 
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Figure A-3 

1.6 View Menu 

The View menu (Figure A-4) allows users to view the current report in either Page Layout view or in 

Draft view, as well as create and edit any existing headers and footers.  The Toolbar, Button Bar, Status 

Bar, and Horizontal and Vertical Rulers are all shown in the Report Editor by default.  The user can 

remove any of these from view by de-selecting them in the View menu.  The user can also adjust the size 

of the report on their monitor by increasing the Zoom % to see a close-up view of the file or decrease the 

Zoom % to see more of the page at a reduced size. 

 

FigureA-4 
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1.7 Insert Menu 

The Insert menu (Figure A-5) allows users to insert files (such as existing report templates), images, text 

frames, hyperlinks, or page breaks.  When inserting a file or an image, a dialog box will appear and the 

user will have to search for the desired file or image in their computer directory.  The user will need to be 

aware of the format of the desired file or image, and select it from the drop down menu beside the “File 

name” drop down menu (Figure A-6). 

 

Figure A-5 

 

Figure A-6 

1.8 Format Menu 

The Format menu (Figure A-7) allows users to change the font type, attributes, position, and color 

through the Character menu item.  Changes to paragraph formatting and indents, and frame and page 

breaks can be made through the Paragraph menu item.  Tab stops, bullets and numbering, borders, 

columns, and headers and footers can be customized through their respective menu items.  A specific 

combination of a font type; paragraph formatting, indents, frame and page breaks; tab stops; and bullets 

and numbering can be saved as a particular Style through the Styles menu item and used in future reports.  

The text color and background color can be easily changed through their respective menus found at the 

bottom of the Format menu.   
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Figure A-7 

1.9 Table Menu 

The Table Menu (Figure A-8) allows users to insert, delete, or select a table, as well as merge or split 

cells found in the table(s).  Grid lines in tables can be turned on or off through this menu, and rows and 

columns can be added or deleted though the “Insert” and “Delete” menus found within the Table Menu. 

Users may highlight several cells in a table and choose “Merge Cells” (either through the Table Menu, or 

right click and select “Merge Cells”) to combine those cells together.  To split cells that have been 

previously merged, left click in the cell that is to be split, and select “Split Cells” (either through the 

Table Menu, or right click and select “Split Cells” from the drop-down menu).   To customize table 

properties, left click anywhere inside the table and select Properties from the Table menu.  Alternatively, 

users can right click anywhere inside the table and select “Table Properties”.  The frame width, table and 

background color, cell margins, and text alignment can all be specified through the Properties menu.  

 

Figure A-8 
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1.10 Toolbar and Button Bar 

The Toolbar beneath the Menu Bar (Figure A-9) allows users shortcut access to several frequently-used 

features found under menus in the Menu bar.  Reports can be created, opened, saved, and printed through 

their respective shortcuts in this Toolbar.  Images or text can be cut, copied, pasted, or deleted; actions 

can be undone and/or redone; words can be searched for; and headers can be formatted through the 

Toolbar.  The Page Setup menu can also be easily accessed through the Toolbar.  To see which shortcut a 

button corresponds to, the user may hover their mouse over the button and a description of what the 

button does will appear (Figure A-10).  The Button Bar allows users to quickly change their paragraph 

style, font, font size and attributes; change the alignment of the text; create a bulleted or numbered list; 

zoom in or out of the report; view paragraph marks and other formatting symbols; and create or modify 

existing tabs.  

 

Figure A-9 

 

Figure A-10 

2.0 Using the Report Editor 

Users have three options when customizing a report template:  Create a new report template, upload a 

template that is currently being used in their lab, or use one of the default report templates.    

2.1 Creating a new template 

To create a new template, open the Report Editor by selecting Report Editor in the Viewer File menu.   

The Report Editor will open and the document will be blank.  The user can now insert tables, headers and 

footers, images, and page numbers, as well as label specific fields that they wish to include in the report, 

format font, and use many other features as described in section 1 above.  

Once the user has created the report template, they will then have to insert the Unique Identifier Keys 

(further explained in 2.1.4) in the report that pertain to each data field.  The “Fields” section on the right 

Button Bar Toolbar 
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side of the Report Editor contains three categories of fields:  General Fields, Data Fields, and Graphs and 

Tables Fields (Figure A-11).   

 

Figure A-11 

2.1.1 General Fields 

The General Fields allow for entry of relevant dates and times (Time of Study Start, Time of Study End, 

Time of Lights Off, Time of Lights On, Time of CPAP On, Time of Sleep Onset, Time of Sleep End, 

Total Recording Time and Today’s Date), general information about the sleep study (Study Date, Study 

Type, ID#), patient information (Patient Name, Gender, Date of Birth, Patient Age, Social Security #, 

Healthcare #, Neck Circumference, Weight, Height, BMI, Epworth Scale, Medications), names of 

medical personnel (Referring Doctor, Interpreting Doctor, Collection Technician, and Scoring 

Technician), and miscellaneous information (Page Number and Hypopnea Criteria, which indicates the 

Hypopnea Type that was selected in the Channel Mapping window before sending the file for scoring in 

the Viewer ). In the final report, the information specified in the General Fields will precede the tables 

and graphs that contain results of autoscoring.  

The Cover Sheet is a special field that allows importing of patient information into the final report. To 

utilize it, drag and drop the code $coversheet$ onto the report; it will then call information from the 

Report Generator Options Window (see Figure A-22 below). The information is stored in an .rtf file that 

is created prior to generating the report. The .rtf file can be loaded by clicking on the button.  
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The .rtf file should look something like this: 

 

2.1.2 Data Fields 

The Data Fields section includes fields for Sleep data, Body Position, Respiratory Events, Arousals, Leg 

Movements, Oxygen, Heart Rates, and Snoring for Pre- and Post-CPAP as well as the combined results 

when needed (e.g. Split Studies). 

Sleep data is categorized into General Items, Staging Breakdowns, and ORP.  General Items which may 

be included are Wake After Sleep Onset, Sleep Period Time, Awake as % of Sleep Period Time, Sleep 

Efficiency, and REM Latency Minus Wake Time.  The Staging Breakdown field allows users to include 

information on Time in Stage, % Total Sleep Time, % Total Study Time, Shifts into Stage, Latency from 

Lights Out, and Latency from Sleep Onset for all stages (including awake), all sleep stages, and/or the 

individual sleep stages (Stage 1, Stage 2, Stage 3, including REM and NREM, REM/Supine, REM/Non-

Supine, NREM/Supine and NREM/Non-Supine)  ORP allows the user to determine quality of sleep for 

Wake, All Sleep Stages including REM, Wake (After Sleep Onset), All, and/or All (After Sleep Onset). 

The Body Position field allows users to include data on Total Time Including Awake, Total Time Sleep 

Only, % Total Study Time, and % Total Sleep Time for each individual body position the patient was in 

(Supine, Prone, Upright, Right, Left, Lateral and Non-Supine).  
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The Respiratory field allows users to include data collected regarding the Number, Index, Maximum 

Duration, Average Duration, Minimum Duration, Total Duration (Minutes) and % Total Sleep Time for 

Undefined Apneas, Central Apneas, Obstructive Apneas, Mixed Apneas, Obstructive Hypopneas, 

Undefined Hypopneas, All Hypopneas, RERAs, All Apneas, Apneas + Hypopneas, and All Events that 

occurred in the sleep-portion of the study.  Respiratory event data can also be specified by the stage of 

sleep the events occurred in (including REM and NREM), and/or which body position the patient was in 

when the event(s) occurred (Supine, Prone, Upright, Right, Left, Lateral, Non-Supine, REM/Supine, 

REM-Non-Supine, NREM/Supine, and NREM/Non-Supine). 

Arousal data, which include Number and Index of: Respiratory, PLM, Spontaneous, Awakenings, and 

Total Arousals, are able to be broken down into the same categories as Respiratory Events as described 

above (All Sleep, individual sleep stages (including REM and NREM), and/or body position). 

The Leg Movements field allows users to include data on the Number, Average Duration, Total Time, and 

% Total Sleep Time of PLM Chains.  Users can also include summaries of the Number and Index of all 

Leg Movements that occur With Arousal, Without Arousal or Total Movements (with and without 

arousal) in All Sleep Stages, individual sleep stages (including REM and NREM) and/or by body 

position.   

The Oxygen field allows data collected on Oxygen levels to be inserted into the report.  Users have the 

option of including Desaturations > 2% Count, Desaturations > 2% Index, Desaturations > 3% Count, 

Desaturations > 3% Index, Desaturations > 4% Count, or Desaturations > 4% Index, Lowest SpO2 with 

Longest Apnea, Lowest SpO2 with Longest Hypopnea, Average Desaturation Amplitude, and/or Lowest 

SpO2 with Respiratory for All (entire study), All Sleep Stages, All Awake, individual sleep stages 

(including REM and NREM), and/or by body position.  Additionally, users have the option of including 

Summaries of the Maximum Saturation, Average Saturation, Minimum Saturation, % Sleep Time > 90%, 

% Sleep Time 80-90%, % Sleep Time 70-80%, % Sleep Time 60-70%,% Sleep Time 50-60%, % Sleep 

Time < 50%, % Sleep Time < CUSTOM% (a custom oxygen threshold the user can define when 

generating the report, see “Including a Custom Oxygen Threshold”, section 3.4),  % Sleep Time, Bad 

Signal for All (entire study), All Sleep Stages, All Awake, individual sleep stages (including REM and 

NREM), and/or by body position. 

Alternatively, the oxygen times can be reported in minutes.  

Note: The custom oxygen threshold will include all the values below, but not including the specified 

value (e.g. If a user enters 83% in the report generator, the field would include values from 0-82%). 

Heart Rate data (Maximum, Average, Minimum, and 95th Percentile) can be inserted into the report 

through the Heart Rates field.  Heart Rate data can be included for All (entire study), All Sleep, All 

Awake individual sleep stages (including REM and NREM), and/or by body position. 

Snoring data (Number of Snores, Epochs with Snoring, Sleep Time with Snoring, Snore Index and % 

Sleep Time with Snoring) can be inserted through the Snoring field. Snoring data can also be specified by 

the stage of sleep the events occurred in (including REM and NREM), and/or which body position the 
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patient was in when the event(s) occurred (Supine, Prone, Upright, Right, Left, Lateral, Non-Supine, 

REM/Supine, REM-Non-Supine, NREM/Supine, and NREM/Non-Supine). 

 

 

2.1.3 Graphs and Tables Fields 

The Graphs and Tables fields allow users to include graphs summarizing Sleep Staging, Body Position, 

Respiratory Events, Leg Movements, Oximetry, PAP Pressure, Audio, Heart Rate, Average Delta EEG1, 

Average Delta EEG 2, Full Graph, Hypnogram Vs O2, Heart Rate  Type2 (different version), a sample of 

any channel (labelled as “ECG Sample”), and/or a CPAP/BiPAP Summary table. The Full Graph, 

Hypnogram Vs O2, Heart Rate Type2 and ECG Sample graphs were specifically made for one user, but 

are available for useby any user if so desired. For a full description on how to use the ECG Sample 

function see Section 3.5 below. 

  

2.1.4 Unique Identifier Keys 

Once the user has determined which data, graphs, and/or tables they would like to include in their report, 

they can click the particular field, and drag it over into the appropriate column in a table or field in the 

report.  E.g. if a user wanted to include Time of Lights Off, they would expand the General field by 

clicking the + symbol beside “General”, then expand the “Dates and Times” field in the same manner, 

click and hold “Time of Lights Off”, and drag the item into the correct place in the report.  The data will 

appear as a Unique Identifier Key (Figure A-12).  This Unique Identifier Key will be replaced with the 

appropriate data once the report is generated.  Do not delete or modify any of the Unique Identifier 

Keys as this will affect how the report is generated and may result in incorrect data being displayed 

in the report.  

 

Figure A-12 

2.1.5  Finalizing and Accessing the New Report Template 

The user may now save the report template by either clicking on the Save shortcut on the Toolbar, or by 

selecting “Save As” under the File menu.  Users will be prompted to enter a report name (e.g. CPAP 

Report). 
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Once a custom report has been created, it will be available to be opened and modified as needed in the 

future.  Users may access previously created reports through the Open shortcut in the Toolbar, or by 

selecting “Open” under the File menu.  Please note that saved report templates are only stored within the 

Viewer, and will not be accessible through the user’s hard drive. 

2.2 Uploading a Preexisting Report Template Into the Report Editor  

To insert a preexisting report template, select “File” from the Insert menu.  The user will be presented 

with a window in which they can locate the report template on their computer.  The report editor can 

upload .rtf , .html, .doc, .docx, .xml, .pdf, .txt, and .tx file formats.  Please note that the user must be 

aware of the format of the document they are uploading, and ensure that this is selected when locating the 

file (Figure A-13).  

 

Figure A-13 

Once the user has uploaded their template report, they may click the fields that they wish to include in the 

report and drag the Unique Identifier Keys into the appropriate fields in the template as described in 

section 2.1.4 above. 

The report may then be saved as described in section 2.1.5 above. 

2.3 Using a default template 

There are five template reports that are preloaded into the Report Editor.  The five preloaded reports are 

titled, “Michele Diagnostic Report”, “Michele CPAP Study”, “Michele Split Study”, “Michele Level 3 

Rx Report”, and “Michele Level 3 Dx Report”.  These preloaded reports include the data fields that are 

most commonly used in reports for those particular types of studies.  However, users may add extra fields 

to the template reports, or remove fields that they do not want included in their reports.  The template 

reports may be customized for each lab by adding additional tables, inserting columns and/or rows, or 

deleting tables and removing columns and/or rows as described in section 1.9 through the Table menu.  

The user would then click and drag the Unique Identifier Keys into the new table cells they have created 

as described in 2.1.4.  Customized lab information, such as a logo or address, may be added through the 

header and footer as described in section 1.6 above. 

2.4 Importing and Exporting Report Templates 
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Users have the ability to copy report templates for other users to import and utilize within their operation.  

This allows a sleep lab to create a report template once (or one per study type) and have the report 

template(s) used in multiple Viewers within their lab.  To import or export a report template, select the 

File menu at the top left corner of the Viewer and select “Import/Export Reports” (Figure A-14). 

 

Figure A-14 

A dialog box will appear as shown in Figure A-15 below: 
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Figure A-15 

 

 

 

 

2.4.1 Exporting Reports 

If the user wishes to export reports, select “Export Reports”.  A dialog box will appear as shown in Figure 

A-16.  Users will need to specify the file location where the report template(s) is to be copied by clicking 

on the ‘...’ button next to the report name.  Choose the location through the file directory.  By default, the 

exported reports are saved as “export.rep”, but users may rename the export if they wish (Figure A-17).  

Users will then click “Save”, and a dialog box will appear noting that the exported report file does not 

exist and ask if the user wants to create it.  Click on Yes.  Once the report export has been saved, users are 

returned to Figure A-15 above but the text box will now be filled in with the file path that was specified.  

Users are now able to click “Next’ to proceed. 

 

 
 

Figure A-16 

 

 
 

Figure A-17 
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Users will then select which reports they would like to export.  A dialog box will appear listing all 

customized reports that have been created on the user’s computer (Figure A-18).  Select a single report 

template by clicking on its name, or select multiple report templates by clicking on multiple file names.  

To deselect a report, click on the file name a second time.  After selecting the reports to export, click 

“Next”.  A dialog box will appear confirming that the export was successful (Figure A-19).  The dialog 

box will indicate that the exported file must be transferred to be imported to another computer.  

Transferring the exported file can be done via attachment to e-mail or a usb flash drive; however users 

may wish to save the exported reports on a shared network drive that can be accessed by other users 

wishing to use the Viewer.   

 

 
 

Figure A-18 
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Figure A-19 

 

2.4.2 Importing Reports 

To import report templates that were previously exported, select “Import Reports” shown in Figure A-15, 

and browse for the exported reports using the “…” button to the right of the text box.  After the exported 

file has been located, click on it and select “Open”.  Users will then be returned to the dialog box shown 

in A-16 and can select “Next”.   

 

A dialog box will appear listing the report templates contained in the exported report file (Figure A-20).  

Select a single report template by clicking on its name, or select multiple report templates by clicking on 

multiple file names.  To deselect a report, click on the file name a second time.  Select “Next” to continue. 
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Figure A-20 

 

If a report is being imported that has the same file name as a report already present on the user’s 

computer, a dialog box as shown in Figure A-21 will appear.  Click the duplicate report name and type a 

new file name for the report in the text box below.  Select “Rename Report” to continue.  Once all 

duplicate files have been renamed, users can select “Next”.  

 

 
 

Figure A-21 

 

A dialog box will appear indicating that the import has been successful and the new reports will be 

available for use via the report selector.  Select “Finish” to close the dialog box. 
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Users can edit, rename, or delete the imported report templates by selecting “Report Manager” from the 

File menu shown in Figure A-14.  To open an imported report template, open the Report Editor as 

described in section 1.1, select “Open” under the File menu or select the Open shortcut in the Toolbar.  A 

dialog box will appear, and users may then select the Report they wish to open. 

 

3.0 Using the Customized Report(s) 

Once the user has created their customized reports, they can now generate these customized reports from 

scored patient files, as described in the following steps. 

3.1 Sending the file for scoring 

The user sends the file for scoring and downloads the scored file as described in section 4.0 of the User 

Manual. 

3.2 Downloading and Reviewing the scored file 

After downloading the scored file, the user must review and edit the file as necessary as described in 

section 5.0 of the User Manual.  

3.3 Generating the Customized Report 

Once the user has completed their review and edit of the scored file, they would select “Generate Report” 

from the File menu or the Generate Report shortcut icon on the Toolbar of the Viewer.  A window will 

then pop up prompting them to enter Patient Information (Figure A-22).  This Patient Information will 

appear in the Report as it is typed in these fields.  Patient Information can be imported by clicking the  

“Import Patient Info” button near the bottom right of the Report Generator Window.  A file directory will 

open where users can browse their computer and select the patient information .txt file that pertains to that 

particular study.  The Report Generator will then ask the user which data collection system was used 

(Figure A-23).  The user may also enter the patient information manually.  Users can  enterthe patient’s 

weight in pounds or kilograms from the drop-down menu (Figure A-24).  Height can be entered as feet 

and inches, inches, centimeters, or meters (Figure A-25).  Units are automatically added to the Height and 

Weight fields in the report.  Ex: Entering “200” and selecting “lbs” will appear as “200 lbs” in the report.  

If the user would like the Report Generator to calculate the patient’s Body Mass Index (BMI), check the 

“Automatically Calculate BMI” box.  The BMI value will not appear in the Report Generation Options 

window but will be calculated and appear in the report.  Alternately, the user can manually enter the 

patient’s BMI by unselecting “Automatically Calculate BMI” and typing the data into the text box.  

Please be sure to scroll down as there are additional fields to be filled in below what is initally 

presented in the Patient Information menu.  
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Figure A-22 

 

Figure A-23 

 

 

 

 

  Figure A-24    Figure A-25 
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3.4 Including a Custom Oxygen Threshold 

Users may enter a custom oxygen threshold to be included in the report as described in section 2.1.2 

above (Oxygen Data Fields).  To do this, scroll to the bottom of the Patient Information menu or left click 

the “^” button beside “Patient Information” to collapse the menu.  A “Reporting Options” menu will 

appear, and users can enter in a numerical value that will capture the total % of sleep time and/or minutes 

of sleep time that occurred under that specified oxygen level (Figure A-26) (e.g. if a user enters “73” into 

this field, the report will display the total % of sleep time and/or minutes of sleep time that occurred when 

the patient’s oxygen saturation was anywhere from 0-72.99%).  By default, this value is set to 0.  If users 

do not wish to use this feature they can leave the value as 0. 

 

Figure A-26 

3.5  Outputting a Sample Channel 

If desired, the user may display a sample of any of the channels in the EDF file in the report. The start 

time of the sample may be selected as seen in Figure A-26, where it shows “Baseline ECG Start (Epoch)”. 

The sample may be 30, 60, 90 or 120 seconds in length, and the length of the sample is selected in the 

drop-down box shown to the right of the start time. Which channels are displayed (there can be as many 

as the user desires) is determined by clicking on “ECG Display Channels”, situated above the “Generate” 

box as shown in Figure A-26. For the sample(s) to show up in the report, the corresponding code for ECG 

Sample must be present in the report template. The code for ECG Sample is “$ECGSample$”, which can 

be foundd in the Graphs menu. 
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3.6 Selecting a Report Template 

Once the Patient Information has been entered, the user must select the report template they wish to use.  

In the drop-down menu, users will see a list of all report templates they have created (Figure A-27).  

Default reports described in section 2.3 can be selected through this menu also.  Select the appropriate 

template as well as the output file format for the report (Figure A-28).  Please note that *.rtf reports will 

be able to be modified after generation, whereas *.pdf reports will not be modifiable.  In order to generate 

a report, it must first be confirmed that the scoring data used to generate the report is correct.  The scoring 

data that is used is the currently selected file.  A report cannot be generated from a read only scoring file 

provided by YST.  The scoring data is confirmed by checking the Events have been Verified checkbox, 

which in turn enables the Generate button.  Users will then select “Generate” and a window will appear 

displaying the generation progress (Figure A-29). 

 

 

 Figure A-27 

 

Figure A-28 

 

Figure A-29 

 

3.7 Opening the Customized Report 
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The report will automatically open in either Microsoft® Word (for *.rtf reports) or Adobe Reader (for 

*.pdf reports).  The report can then be printed or saved to the user’s hard drive. 

3.8 Using the Report Manager 

Users can edit, delete, or rename any custom report template they have created by accessing the Report 

Manager found in the File menu of the main Viewer window.   
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